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1. Introducción
Anim8or es un programa de animación de 3D diseñado para permitir una respuesta directa a la
creación de animaciones.  Usted puede interactivamente crear y editar objetos, figuras, y escenas
directamente en la pantalla de la computadora. La interfase básica es similar a la mayoría de los
programas 3D y CAD, como se muestra en la imagen siguiente:

Usted puede controlar varios aspectos de su trabajo usando un mouse o tableta. Puede seleccionar,
arrastrar, rotar, escalar y colocar objetos cliqueando en las distintas vistas de su trabajo.  Hay dos
Barras de Tareas (Toolbars ) que se pueden usar para lateas comunes. Una de ellas en la parte
superior de la ventana para comandos generales usados en Anim8or, la otra sobre la izquierda
permite cambiar el modo de operación para tareas comunes en el editor que se encuentre usando. 
El menú es para las tareas menos frecuentemente usadas.

Usted puede controlar la presentación de sus objetos para verlos aparecer de frente, lado, arriba,
perspectiva, etc., y puede mostrar vistas múltiples o una sola vista en su pantalla.

Hay cuatro modos de trabajo principales, y un modo de navegación de objeto.

Primero, hay un Editor de Objeto (Object Editor) que se usa para construir (principalmente) objetos
estáticos.
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Segundo, hay un Editor de figura o carácter (Character Editor). Usted lo usa para definir la
estructura de la figura que busca animar, mediante la conexión de huesos (bones) articulados entre
sí, y vinculando objetos a ellos.  Puede  mover las articulaciones de muchas maneras diferentes, o
restringir el rango de movimiento, como para codos y hombros que sólo se pueden mover de cierta
manera.

Tercero, hay un Editor de secuencias (Sequence Editor). Puede definir segmentos de movimiento
como un ciclo para caminar. Ellos se pueden conectar como eslabones de una cadena en el editor
de escenas para obtener secuencias más extensas.

Cuarto, usted coloca juntas sus escenas finales en el Editor de escenas (Scene Editor). Aquí coloca
los objetos y figuras realizadas con otras partes de Anim8or en su "mundo" final.  Puede controlar
como ellos se moverán, y dónde se colocará la cámara (camera). Puede también poner en la escena
distintas clases de luces (ligths).

Una vez creado el modelo o escena, puede renderizar imágenes .jpg y .bmp (images) de alta
calidad y películas .avi (movies) y guardarlos en un disco para uso posterior.

Finalmente, hay un buscador de objetos (object browser) para ayudarlo a ver y organizar sus
objetos Anim8or. Puede además buscar en su disco objetos en otros formatos.

This page was last updated on August 30, 2001. Copyright 2001 R. Steven Glanville
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2. Básicos
Uso del Mouse
Anim8or requiere el uso de un mouse de dos botones.  Usted usa el izquierdo la mayor parte del
tiempo para seleccionar, mover y cambiar objetos.  Cuando selecciona una cosa con el botón
izquierdo, siempre des selecciona todo que tiene de antemano, así sólo un único ítem queda
seleccionado. El botón derecho por otro lado,  permite seleccionar múltiples ítems agregando
nuevas selecciones a las existentes. A partir de la versión 0.7 puede usar el botón del medio para
des seleccionar cualquier selección. Si no tiene botón del medio, puede conseguir este efecto
manteniendo apretada la tecla alt en combinación con el botón derecho del mouse.

Cuando de mueve, rota o se produce un cambio no uniforme de escala en algo, el botón izquierdo
produce el cambio en relación a los ejes X e Y. Moviendo el mouse a izquierda y derecha afecta el
eje X y arriba y abajo afecta el eje Y.  El botón derecho cambia el eje Z.

Algunas operaciones requieren el uso del botón del medio. Si está usando un mouse de sólo dos
botones utilice el siguiente comando: Mantenga apretada la tecla alt primero y use el botón derecho
como si fuera el del medio.

Usted puede a menudo utilizar el doble clic en algo para desplegar un menú de edición para ese
ítem.

 

Dónde está Deshacer?
A partir de la versión 0.7, Anim8or tiene un completo comando deshacer (undo) para Objeto, Figura,
Secuencia y Editores de Escena. Mientras esté en cada Editor, puede deshacer y rehacer (redo)
múltiples comandos de edición. Una historia de los cambios se mantiene en un buffer de cerca de 1
MB de memoria.  A menos que esté trabajando con modelos grandes, tendrá disponible varios
niveles para deshacer.

Usted usa los comandos de menú Edit->Undo y Edit->Redo para deshacer y rehacer, o puede usar
los atajos de teclado Ctrl-Z y Ctrl-Y.

Como alternativa a deshacer, puede usar el original ( simple y por todos conocido ) substituto:
Cuando esté arrastrando el mouse en la ventana principal para cambiar algo, como la orientación de
un objeto y usted piensa "Oops! Yo no quería hacer esto", simplemente mantenga arrastrando el
mouse hasta estar fuera de la pantalla y suelte el botón. Esto cancelará la operación.

Todavía, cuando uso este y otros programas de computadora, siempre recalco el mismo consejo:
"Guarde Temprano, Guarde a menudo". No guarde siempre el mismo archivo. Siempre tenga un
backup reciente a mano.

 

Ayuda sobre Herramientas
Usted puede habilitar la Ayuda sobre Herramientas con en comando de menú
Options->ToolTips. Entonces, si posa el cursor del mouse sobre un botón de la barra de
herramientas, se  mostrará su función en la barra de estado.
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Barra de Herramientas y Menús

Aquí hay una porción de una típica barra de herramientas. Tiene en ella varias
secciones que controlan diferentes aspectos de su entorno. Lo primero que
usted debe notar es que algunos de los íconos de los botones están en

BLANCO  , algunos están en  NEGRO  , y pocos están en

GRIS  .  Los blancos indican que el modo asociado u opción está
actualmente seleccionada o activa. Los negros indican que no están
seleccionados.  Los grises muestran opciones que no están actualmente
disponibles.

El grupo superior central de botones indican el actual modo de edición de la
vista activa. Cuando usted cliquea en uno de ellos, este se resalta y queda
seleccionado.  Todos los otros son des seleccionados. El significado de los
botones en estos grupos, y el de otros botones comunes, se describen más
abajo.

Significado de los Botones Comunes
El grupo de más arriba puede tener hasta 4 botones en él. Cuando usted cliquea en uno se elige el
modo indicado, y cambia la parte inferior de la barra de herramientas para mostrar las funciones
presentes en el nuevo modo. Los distintos modos son:

Este botón indica que usted se halla en el modo más básico de seleccionar-y-editar para el
editor que se halla usando actualmente. Puede usarlo para muchas operaciones como
seleccionar cosas y acciones de edición común.

Este botón es usado para cambiar la vista o vistas en el espacio de trabajo. Con él puede ver
panorámicamente, hacer zoom y escalar cada vista en forma independiente.

En este modo usted puede mover y rotar el pivot para objetos en su espacio de trabajo. El
pivot es el punto y orientación que se usa cuando escala o rota cada objeto.

Use este botón para moverse dentro del modo edición de punto. Le permite a usted agregar,
mover y modificar puntos individuales, aristas y caras en un objeto de malla editable.

Los tres pequeños botones de la próxima fila   muestran los tres ejes del mundo 3D. Ellos
indican cual eje está "desbloqueado", permitiéndole mover y rotar cosas en cada dirección. Puede
seleccionar o des seleccionarlos individualmente, y de esa manera restringir de los objetos que está
editando.
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Abajo de estos botones, puede encontrar tres pequeños botones más   que forman un
grupo.  Ellos muestran el actual sistema de coordenadas del sistema que se encuentra usando. 
Puede elegir entre coordenadas con relación al mundo, objeto o pantalla para manipular cosas.

Encontrará que hay varias barras de herramientas con botones comunes que tienen el mismo o
similar significado en más de un modo de edición. Se describen a continuación:

Usted usa el botón de flecha para seleccionar componentes individuales. Cuando usted
cliquea sobre un objeto usando el botón izquierdo del mouse, usted lo selecciona y al mismo
tiempo des selecciona cualquier objeto seleccionado previamente.  Cuando usa el botón
derecho del mouse, usted mantiene la actual selección de objetos, y selecciona objetos
adicionales.

Con este botón, puede cliquear y arrastrar para mostrar las esquinas de un rectángulo de
selección.  Cualquiera y todos los objetos encerrados en se área son seleccionados.
Nuevamente, el botón izquierdo des selecciona cualquier selección previa, mientras que el
derecho no.

Este el botón para la función de movimiento. Lo elige cuando busca mover objetos dentro de
la pantalla. Cuando presiona el botón izquierdo del mouse dentro de la ventana, puede
arrastrar todo lo actualmente seleccionado en las direcciones X e Y moviendo el mouse
hacia derecha e izquierda y arriba y abajo respectivamente. Los objetos se moverán junto al
cursor del mouse. De manera similar, el botón derecho del mouse los moverá a lo largo del
eje Z..

Este es el botón para rotación, usado para rotar las cosas. Cuando usted cliquea y arrastra
con el botón izquierdo del mouse, los objetos seleccionados rotarán alrededor de los ejes X e
Y con el movimiento del mouse. Puede usar el botón derecho para rotar alrededor del eje Z.

Este botón es para escalado no-uniforme. Con él puede escalar objetos independientemente
en las direcciones X e Y usando el botón izquierdo del mouse, y en la dirección Zcon el botón
derecho del mouse.

Este escala objetos en todas las dimensiones simultáneamente.

Este es un set de botones estilo VCR para controlar la reproducción de sus
animaciones. Puede usar estos botones de la misma manera que lo hace con una VCR
o reproductor de cinta stándard..

   

Barra de Herramientas Superior
Esta es la barra que se encuentra en la parte superior de la ventana. Puede usarla para varias tareas
comunes a través de Anim8or.

Los botones en la parte superior de la barra hacen lo siguiente:

Undo - Si está habilitado puede usarlo para deshacer los más recientes comandos de edición.
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Redo - Restablece los comandos que deshizo.

Delete - Borra cualquier componente seleccionado.

Wireframe - Cambia la ventana de trabajo de su objeto a Malla de Alambre.

Flat - Cambia las vistas a Caras Planas.

Smooth - Muestra los objetos con Suavizado.

Material - Muestra/Oculta la barra de Materiales.

Arc Rotate - Habilita la herramienta de Rotar en Arco.  Puede fácilmente aplicar panorámicas,
zoom, y rotación con esta herramienta a cualquier vista. Se describe en detalle más adelante
en este capítulo.

Snap to Grid - Habilita/Deshabilita el modo Pegar a la Grilla.

   

Atajos por Teclado
Puede utilizar combinaciones de teclas para muchas operaciones comunes. Algunas son atajos para
comandos de menú, y se muestran a la derecha del nombre del comando en el menú.

Alt Cuando se presiona y mantiene antes de usar el botón derecho del mouse, simula el
botón del medio del mouse..

Ctrl-A Select All - Selecciona todos los objetos en la vista actual.

Ctrl-C Copy - Copia cualquier objeto seleccionado en el clipboard de Anim8or.

Ctrl-F Filled view - Muestra objetos como sólido en lugar de malla de alambre.

Ctrl-R Arc Rotate - Habilita/Deshabilita el modo Rotar en Arco.

Ctrl-V Paste - Pega objetos desde el clipboard en la vista actual.

Ctrl-W Wireframe view - Muestra objetos como malla de alambre en lugar de sólido.

Ctrl-X Cut - Corte cualquier objeto seleccionado en el espacio de trabajo, y lo copia dentro del
clipboard de Anim8or.

Ctrl-Y Redo - Restaura un comando deshacer.

Ctrl-Z Undo - Deshace el último comando de edición.

Ctrl-Shift Temporariamente cambia a modo selección. Esto le permite seleccionar rápidamente un
nuevo objeto presionando estas teclas simultáneamente y cliqueando el objeto, y retornar
al modo previo cuando suelta las teclas.

Del Esta tecla borra el ítem seleccionado.

Esc Detiene el rendering de la escena.
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a Selecciona ("Flecha") - Cambia selección en el modo Seleccionar.

d Selecciona Arrastrar - Cambia a arrastrar en el modo Seleccionar.

m Move - Cambia al modo Mover.

n Escala no-uniforme - Cambia a modo Escala no-uniforme.

r Rotar - Cambia a modo Rotación.

s Escala - Cambia a modo Escala.

Arrow
Keys

Puede usar las teclas de dirección para rotar, mover o escalar objetos con pequeños
incrementos en el editor de Objetos, y avanzar las pantallas de a una en los editores de
Secuencia y Escena.

   

Rotar en Arco

Cuando presiona el botón de rotar en arco  en la parte
superior de la barra de herramientas de Anim8or muestra
una capa especial sobre el centro de la ventana. Puede usar
el mouse para vista panorámica o escalar y rotar
vistas. Puede ser que le parezca complicado saber como
funciona, pero una vez que le tome la mano le ahorrará
mucho tiempo con relación a otros métodos.

A la derecha está representada la pantalla de rotación en
arco. Hay seis regiones diferentes en la pantalla, separadas
por la marcación verde: el interior y exterior, arriba y abajo,
izquierda y derecha. Cada uno responde en forma diferente
cuando cliquea con el mouse en él, y cada botón del mouse
controla diferentes funciones.

Botón izquierdo - Rota la vista.  Cliqueando en el centro la rota alrededor de los ejes X
e Y. La región exterior rota alrededor del eje Z. Cliqueando dentro de loa cuatro
pequeños cuadrados rota solamente en el eje X (para arriba y abajo) o el eje Y (para
izquierda y derecha).

❍   

Botón derecho - Mueve la vista. El área central le permite mover la vista a izquierda y
derecha, y la región exterior acerca o aleja el objeto. Puede que no sea posible ver
cambios en la pantalla cuando mueva en vistas ortogonales, pero aparecerán en la
vista en perspectiva.

❍   

Botón medio - Ecala la vista. Todas las áreas son iguales cuando escala la vista. Nota:
Si tiene un mouse de dos botones puede presionar y mantener la tecla Alt y su botón
derecho actuará como botón medio.

❍   

Librerías de Objetos Anim8or
Puede usar cualquier archivo de proyecto Anim8or .an8 como librería. Objetos, Figuras, Secuencia, y
Escenas pueden importarse a otro proyecto Anim8or con los comandos de menú Object->Import,
Figure->Import, etc. Puede también exportar objetos individuales con comandos similares como
Object->Export.
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Control de Grilla
Usted puede fijar el tamaño de la grilla (grid) del fondo usada en vistas de edición, o puede dejar
que Anim8or regule el tamaño por defecto de acuerdo a como cambie el zoom, mostrando siempre
un número razonable de líneas de grilla. Use el comando Options->Grid para mostrar el diálogo de
grilla:

Hay dos tamaños de grilla que puede fijar. Uno se usa en Objeto, Figura y Editor de Secuencias, y el
otro se usa en el Editor de Escena..

También puede fijar  pegar-a-la-grilla (snap-to-grid) para el editor de Objetos habilitándolo en la

sección Snap to Grid, o con el botón   en la parte superior de la barra de herramientas. Esto
posicionará los objetos que mueva a lugares en la grilla, facilitando su alineación. Snap-to-grid
también controla el tamaño y rotación para muchas operaciones para darle mayor control en otros
aspectos del modelado. Usted fija el tamaño de la distancia de influencia en la casilla Spacing
(Espacio).

 

Editor de Materiales
El editor de materiales se usa cada vez que usted necesita diseñar el color, textura, transparencia, y
otra propiedad visual de la apariencia del objeto. Se muestra un ejemplo más abajo:
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Materiales es un tema complejo. Este cuadro tiene varios sub-dialogos para ciertas funciones. Hay
un capítulo entero dedicado a describir cómo se usa el cuadro de diálogos de Materiales.

 

Calidad Visual
Usted puede controlar la calidad de las imágenes mostradas cuando edita, así como la calidad de la
salida de imágenes como archivos. Esto se controla a través del cuadro de Parámetros que se
encuentra bajo el menú View->Preferences.  Luce así:
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La última área, Velocidad de Cuadro (Frame Rate), fija el número de imágenes usadas para hacer
un segundo de animación. Todo archivo de salida .avi se genera con esta velocidad de marco. Si se
marca el cuadro Limit Playback, entonces Anim8or limitará la velocidad de reproducción en los
editores de Secuencia y Escena. De otra forma se reproducirá tan rápido como sea posible.

 

Espacio de Trabajo OpenGL
Esta sección controla la apariencia de su espacio de trabajo interactivo. Puede ver sus objetos como
modelos de malla de alambre (wireframe), como objetos de caras planas (flat), o como objetos
sólidos suavizados (smooth).

Muchas tarjetas gráficas muestran imágenes de sólidos suavizados a la misma velocidad que las
caras planas, así puede pensar que las caras planas no se ven muy bien, pero a veces ayuda ver
facetas individuales en un modelo.
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Texturado y mapeado, pueden a veces tener respuesta lenta de su computadora, así que use la
casilla de chequeo para habilitarlos o deshabilitarlos a su criterio. También el texturado puede ocultar
la estructura de sus modelos, por lo que a veces no es conveniente verla.

Puede agregar niebla (fog) a escenas de Anim8or. Objetos a cierta distancia gradualmente se
pierden en el color de la niebla. La niebla es sólo visible en la vista de cámara del editor de Escena.

 

Archivo de Salida
Los archivos de imágenes son renderizados usando un software acelerado por OpenGL, así la
velocidad de renderizado de su archivo puede ser afectada severamente de acuerdo a los
parámetros que haya elegido.

Las sombras Gouraud son más veloces que las Phong, pero no son adecuadas para mostrar
brillo. De forma similar, el anti-aliasing ayuda a remover los dientes pero incrementa el tiempo de
proceso.

 

Velocidad de Marcos
La última área, Frame Rate, fija el número de imágenes usadas para hacer un segundo de
animación. Todo archivo de salida .avi se genera con esta velocidad de marco. Si se marca el cuadro
Limit Playback, entonces Anim8or limitará la velocidad de reproducción en los editores de Secuencia
y Escena. De otra forma se reproducirá tan rápido como sea posible.

 

Guardando imágenes como archivos .jpg y .bmp 
Usted puede hacer una vista previa rápida de la imágen de cualquier vista en la que esté trabajando
con el comando File->RenderPreview. Puede también guardar esta imagen como un archivo .jpg o
.bmp, o imprimirla desde este comando.

 

Imprimiendo
Anim8or tiene las opciones usuales Print y Print Preview en el menú Archivo. Pero se ofrece un nivel
adicional de control sobre sus imágenes impresas, permitiendo el control del tamaño y otras
propiedades de la imagen a imprimir.  Esto no es nada raro para impresoras que tienen una
resolución de 1440 por 720 dpi.  Pero generar una imagen de 8.5" por 11"  a esa resolución no es
práctico. En cambio Anim8or usa por defecto un tamaño de 1024x768 que puede ajustar de acuerdo
a sus necesidades.

 

Configuración
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Anim8or tiene como base 3 directorios de trabajo. Uno se usa para almacenar archivos de proyecto
Anim8or (.an8) y los otros son los directorios por defecto para guardar Texturas e importar y exportar
objetos. Usted puede fijar estos directorios con el cuadro de diálogo Configuración mediante el
comando File->Configure:

Cuando usted carga o guarda un archivo de proyecto, Anim8or usa inicialmente el directorio de
proyecto por defecto. Puede cambiar este directorio mediante el cuadro de diálogo de Configuración.

Cuando usted carga un archivo de proyecto, Anim8or busca archivos de textura en tres directorios. 
Primero busca en el mismo directorio de el archivo .an8.  Si esto falla, busca en el directorio de
Texturas fijado mediante el diálogo de Configuración. Como última alternativa Anim8or usa el camino
completo guardado en el archivo de proyecto, que es donde el archivo de textura se encontró
inicialmente.

El directorio de importación, es simplemente el lugar donde por defecto irán los archivos de cualquier
formato que se importan y exportan.

Puede hacer que Anim8or cargue automáticamente el último proyecto usado mediante la marcación
de la casilla Start in Previous.

Si marca la casilla Associate .3DS le será posible empezar Anim8or mediante un doble clic en
archivos .3ds en Windows.

This page was last updated on August 30, 2001. Copyright 2001 R. Steven Glanville

Anim8or Basics



 

3. Editor de Objetos
Básico y Objetos/Modo Edición
El editor de objetos (Object Editor) es donde usted crea y modifica nuevos objetos 3D. Entra al
editor de objetos por defecto al arrancar Anim8or.  Puede entrar en cualquier momento
seleccionando Mode->Object en el menu.

La pantalla básica se muestra más abajo. A la izquierda está la barra de herramientas. Tiene íconos
que representan las tareas más comunes que usted puede hacer. Puede usarla para cambiar el
modo en que está trabajando, agregar primitivas básicas, etc. El menú en la parte superior de la
pantalla se usa menos comúnmente.

El editor de objetos tiene cuatro modos: editar (edit), punto de vista (viewpoint), ejes
(axis), y editar puntos (point edit).  Puede cambiar el modo en que está trabajando
cliquendo uno de los cuatro botones superiores de la barra de herramientas. Esto
también cambiará la parte inferior de la barra de tareas para mostrar los botones
apropiados para el modo.

Modo Objeto/Editar (Object/Edit). Este es el modo inicial en que el editor de objetos se inicia.

Modo Objeto/Punto de Vista (Object/Viewpoint), le permite vista panorámica, escalar, rotar, y
adecuar tamaño a ventana en cualquiera o todas las ventanas de su espacio de trabajo.
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Modo Objeto/Ejes (Object/Axis) le permite desplazar el pivot u origen del objeto.

Modo Objeto/Editar Puntos (Object/Point Edit) le permite manipular individual o grupalmente
los puntos, aristas y caras.

   

 

 

Operaciones en Objeto/Editar
En el modo Objeto/Editar hay varios botones justo debajo de los seis pequeños botones en la barra
de herramientas que se usan para manipular componentes de los objetos. Sus acciones solo afectan
las partes seleccionadas de los objetos.

Puede seleccionar algo cliqueando en el cuando se encuentra en el modo seleccionar
(select).  Este botón lo pone en modo seleccionar. Puede temporalmente cambiar a modo
selección en cualquier momento apretando las teclas Ctrl y Shft.

Puede también seleccionar componentes arrastrando un rectángulo alrededor de el en modo
arrastrar-seleccionar (drag-select).

Este botón le permite mover (move),

rotar (rotate),

escalar no-uniformemente (scale non-uniformly), y

escalar (scale) los componentes seleccionados.

Puede también agregar y editar splines agregando segmentos rectos (straigth) y

curvos (curves). Las Splines son también algunas veces llamadas paths cuando son usadas
como caminos para movimiento.
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Herramienta de edición de textura coordenada. Usted
usa esta herramienta para aplicar mapas de textura en
forma interactiva al objeto seleccionado. Esto agrega
una capa a la pantalla que es similar a la de la
herramienta de rotar en arco usada para cambiar el
punto de vista pero para texturas.
El cuadrado amarillo representa el tamaño básico de la
textura.  Puede mover la textura alrededor del objeto con
el botón derecho del mouse, y rotar su orientación con el
botón izquierdo. El botón del medio escala la
textura. Recuerde que si no tiene botón del medio puede
emularlo con la tecla Alt apretada accionando el botón
derecho.



   

Básico en Objetos
Usted puede agregar nuevos objetos en Anim8or en dos formas. La primera es importando mallas de
formato de archivo 3ds, lwo, y obj. Puede usar el menú Object->Import para hacerlo. La segunda
es empezar con una o más primitivas. La parte inferior de la barra de herramientas de Object/Edit
tiene varios íconos para agregar nuevas primitivas.

Este botón le permite agregar esferas (sphere) como objeto.  Primero haga clic en el.
Entonces mueva el mouse hasta donde quiera que se agregue la esfera. Cliquee y arrastre
para crear la esfera del tamaño deseado.

Si busca agregar varias esferas, use el botón derecho del mouse. Usando el botón izquierdo
del mouse se vuelve al modo selección después de haber agregado un objeto.

Haciendo doble clic en la esfera, se despliega un cuadro de diálogo donde puede cambiar las
propiedades de la esfera.

Este botón agrega bloques (block).  Puede dividirlo internamente en tantas subdivisiones
como quiera en cada eje haciendo doble clic en el bloque para ver el diálogo de propiedades.

Este botón agrega cilindros (cylinders). Puede alargarlo, mantener sus bases abiertas o
cerradas, y fijar el número de divisiones mediante el diálogo de propiedades.

Se agregan varios sólidos platónicos y otros sólidos contenidos con este botón.  Puede
elegir el tipo de sólido usando el menú build->primitives.

Este botón agrega polígonos (polygons) sin relleno a un objeto. Son formados por una
spline editable, asi puede hacer diferentes formas partiendo de un polígono regular.  La
Spline puede ser llenada, extruida, torneada, editada, etc.

Para fijar el número de lados, use el ítem del menú build->primitives->n-gon.
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Con este botón usted crea objetos de texto True Type. Simplemente cliquee en algún lugar
de la pantalla y empiece a tipear. Si busca cambiar las propiedades, haga doble clic en el
objeto. Puede usar cualquier fuente y estilo.

Cada letra es una spline simple ( Posiblemente con múltiples partes como el hueco en la O ),
y una misma cadena de caracteres se encuentra agrupada. Puede extruir objetos de texto
usando el ítem de menú Build->Extrude.

Puede también convertir el texto objeto en un grupo de splines para propósitos generales
usando en ítem de menú Build->Convert_to_Spline.



Mallas vs. Componentes Paramétricos
Hay dos clases de componentes en los objetos Anim8or, paramétricos (parametrics) y malla
(mesh).  Los componentes Paramétricos se definen por un pequeño conjunto de valores numéricos.
Estos valores se usan para construir una malla visible cuando deben mostrarse. Puede editar estos
parámetros mediante doble clic en el componente paramétrico, para luego generar una nueva malla
para mostrar. Pero usted no puede modificar la malla directamente. Algunos componentes
paramétricos son la esfera y cilindros descriptos más arriba.

Las Mallas ocasionalmente pueden ser editadas totalmente, suavizadas, etc., incluso a nivel de
puntos y caras. Puede convertir un objeto paramétrico en malla mediante el ítem de menú
Build->Convert_to_Mesh. Es muy fácil ver si un objeto seleccionado es una malla o no
seleccionándolo. los componentes paramétricos seleccionados se encierran en una caja amarilla y
las mallas en una blanca. En la vista en modo de alambre, los componentes paramétricos se
muestran con líneas amarillas y las mallas en blanco u otro color. Las cuatro esferas abajo, muestran
la misma geometría. La primera y tercera en su forma paramétrica original, mientras que la segunda
y cuarta han sido convertidas en malla.

Una vez que se ha convertido en malla un componente paramétrico, no puede revertirse la
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operación.

 

Este es el botón para modificar (modify). Uselo para doblar, estrechar, torcer y enroscar un
objeto para obtener nuevas formas. Los modificadores se explican con más detalle en una
sección posterior de este capítulo.

Cada objeto en Anim8or tiene su propias coordenadas de sistema. Su pivot es el origen.  Cuando se
escala o rota un objeto, se hace usando su pivot. Cuando utiliza el modo malla de alambre, los pivots
de los objetos seleccionados se muestran como ejes rojo-verde-azul:

Puede mover y rotar los pivots usando el modo edit/pivot.

   



Materiales de Objetos

Usted puede ver los materiales de un objeto desplegando la barra de herramientas
de materiales (material toolbar) desde el menú Options->Materials. Cada material
se muestra aplicado a una pequeña esfera. Haciendo doble clic en la esfera se abre
el diálogo de edición de materiales permitiendo cambiar sus propiedades.

El material seleccionado se muestra como un botón oprimido con el nombre en
blanco. Usted puede poner el material básico a cualquier componente seleccionado
haciendo clic en el botón Aplicar (Apply).

El botón Objeto (Object) muestra el material actual del objeto.

El botón Archivo (File) muestra globalmente los materiales del proyecto, que son
compartidos por todos los objetos en el proyecto completo.  Usted puede agregar a
la lista global, materiales que pueden ser comunes a muy diferentes objetos para
ayudarse a manejarlos mejor.

Si desea definir un nuevo material, simplemente haga doble clic en el botón Nuevo
(New) en el fondo de la lista.

Si hay más materiales de los que pueden mostrarse, puede hacer clic con el botón
izquierdo en la barra de materiales y arrastrar arriba o abajo para desplazar la lista.
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Usted usa los botones spline   línea   para manipular splines.  Para agregar una nueva
spline, usted debe primero des seleccionar todo. Entonces seleccione entre el botón de spline o línea
y haga clic y arrastre para poner el primer segmento. La spline se dibujará con una pequeña cajita

blanca en su origen y otra roja en su extremo, viéndose así: La cajita roja también indicará
que la spline es extendible. Usted puede hacer clic con el botón izquierdo y arrastrar para agregar

nuevos segmentos: Una vez que ha realizado todos los segmentos que necesite,
vuelva al modo selección y haga doble clic en la spline para abrir su diálogo de propiedades y
desactivar la casilla de extendible (extendable) . Esto prevendrá de accidentales extensiones de la
spline cuando trate de modificarla en alguna otra manera. Vuelva al modo spline y lucirá así:

Ahora si usted re selecciona el botón de spline podrá hacer clic en los nodos (knots) y mostrar sus

puntos de control:  Usted puede arrastrar los nodos a nuevos lugares, y cambiar la
ubicación de los puntos de control para alterar la forma de la spline. Con doble clic en un nodo, se
mostrará el diálogo de nodos, donde podrá cambiar el nodo entre nodo suavizado (smooth) o
esquina (corner).

Con doble clic en un segmento, se resaltará el segmento y le permitirá establecer el número de

líneas usadas para dibujarlo: 

 

Fuentes True Type

Cuando usted cliquea en el botón texto (text)  puede agregar texto a un objeto.  Cliquee en la
ventana y aparecerá el cursor de texto. Tipee algún texto y aparecerá como contorno en la ventana.
Doble clic en el texto hará que aparezca el diálogo de texto. Puede cambiar la fuente (font), hacerla
negrita (bold) o italica (italic), y fijar el tamaño (size). Podrá siempre cambiar el tamaño de un texto
objeto, pero no siempre será lo mismo que cambiar su tamaño inicial con el diálogo de propiedades
de la fuente. Las fuentes más grandes a veces se generan con mayor detalle:

Puede también llenar (fill) y extruir (extrude) texto. Use los ítems de menú Build->Fill y
Build->Extrude.
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Splines



Cuando ellos se llenan o extruyen, los textos objeto se convierten en mallas. Luego, usted puede
hacer todo lo que le permite una malla ordinaria.

 

Llenando
Usted puede convertir cualquier spline cerrada en una malla plana llenada (filled).  Para llenar una
spline, simplemente seleccione la spline y aplique el operador de llenado mediante el ítem de menú
Build->Fill. La spline no debe cruzarse sobre sí misma o no se llenará.

 Puede construir además splines complejas
consistentes en múltiples curvas independientes. Las áreas internas cerradas se llenan como
huecos. Para hacer splines complejas, seleccione varias splines y aplique el ítem de menú
Build->Join_Splines. Por ejemplo:

Teniendo en cuenta que los ítems texto son
(posiblemente) un grupo de splines complejo, puede ser combinado con otras splines y
llenarse. Primero seleccione su texto y conviértalo en spline con el menú
Build->Convert_to_Spline. Entonces des agrupe la cadena de caracteres con
Build->Ungroup. Entonces seleccione la spline junto a todos los caracteres individuales y
combínelos en una sola spline múltiple con Build->Join-Splines. Entonces llene el resultado:
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Hay dos operaciones más que puede hacer con splines, son extrusión (extrude) y torneado
(lathe). Ambas crean una malla tridimensional fuera de la spline, pero cada una de diferente
manera. La extrusión barre el eje de una spline a lo largo de un camino (recto o curvo), mientras que
el torneado la gira alrededor de un eje.

Para extruir una spline, simplemente selecciónela y elija el ítem de menú Build->Extrude. Esto
mostrará un diálogo con varios parámetros que puede fijar, como cual cara será el final y la dirección
de extrusión. Una opción es extruir a lo largo de otra spline. Cuando elige esta opción, se le pedirá
elegir la spline después de dejar el diálogo. Algunas extrusiones se muestran más abajo:

Usted puede extruir texto. Sólo selecciónelo y elija Build->Extrude:

Torneando
Torneando (lathing) crea una superficie sólida de una spline por giro de la misma alrededor de un
eje convirtiendo el área barrida en una superficie de malla. Esto puede producir una variedad de
diferentes objetos dependiendo de la forma de la spline que se tornea. Si torna una spline cerrada
puede crear ruedas y roscas. Si tornea una spline abierta, puede hacer jarrones, potes y vasos:
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Subsecuentemente puede aplicar textura por coordenadas al mismo tiempo que tornea una spline,
esto facilita hacer cosas con colores detallados.

Use el comando Build->Lathe para tornear una spline. Esto muestra el diálogo:

La sección Ejes selecciona cuál eje será usado para la rotación. Puede controlar el comportamiento
de los puntos finales de una spline con los cuadros Inicio y Fin. Los tres objetos de abajo han sido
todos torneados con la misma spline, pero el punto de inicio (el de arriba, no el rojo) es manejado de
manera diferente en cada caso.  Abierto deja los puntos de inicio y final donde están. Cerrado agrega
un nuevo punto en el eje al mismo nivel que el punto final y lo conecta con éste, creando tapas
superiores e inferiores planas. Punto mueve el punto final de la spline precisamente al eje y luego
tornea la spline.

Modos Abierto (Open), Cerrado (Closed), y Punto (Point) usados al empezar
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Modificadores
Los Modificadores (Modifyers) le permiten estirar, curvar, torcer, y envolver mallas en una infinita
variedad de formas alternativas. Para usarlos usted crea un objeto modificador y lo aplica (apply) a
una malla existente con el ítem de menú Build->Modifiers->Bind. Usted puede hacer doble clic en
el modificador para abrir su diálogo de propiedades y cambiar su comportamiento. El objeto que lleva
la malla designada se muestra en la vista del objeto. Cuando esté satisfecho con la forma,
seleccione el ítem de menú Build->Modifiers->Effect y la malla se transformará en su nueva forma.

Aquí hay un ejemplo de un cilindro modificado por torcer (twist), afinar (taper), inclinar (skew),
curvatura (curvature), y doblado (bend). Los modificadores preservan la textura por coordenadas y
otras propiedades límite a los puntos del objeto.

 

Reflejando
Usted puede también reflejar (mirror) un objeto usando el ítem de menú Build->Mirror. Esto
construye una imagen reflejada del objeto original, por duplicación de los puntos reflejados del lado
opuesto de un eje X, Y, o Z. Estas manos son simples reflejos de cada una:

Puede a menudo modelar la mitad de un objeto simétrico más fácil de todo el objeto. Para hacer el
objeto completo, refleje la mitad del modelo y únalas.
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Subdivisión
Use subdivisión para redondear las esquinas de formas básicas y conseguir mayor detalle en el
modelo. Anim8or puede subdividir cualquier malla. Sólo seleccione el objeto que quiere subdividir, y
seleccione Build->Subdivide del menú. Cada vez que haga esto redondeará las esquinas un poco
más y multiplicará el número de caras. Así que sea cuidadoso, o creará un modelo muy pesado de
manipular.

Nota: La Subdivisión es llamada suavizado (smooth) en anteriores versiones de Anim8or.

Hay una técnica llamada modelado de caja (box modeling) que puede usar para modelar objetos
complejos que empiezan por una simple caja. Puede biselar, extruir, cambiar el tamaño, y torcer
unas pocas caras planas hasta tener el objeto deseado. Entonces suted aplicará subdivisión, y
tendrá un bello modelo. Los modelos siguientes han sido hechos en Anim8or usando modelado de
caja:

No están mal
considerando que han sido modelados mediante 24 simples cubos!  Puede aprender más a cerca de
construir formas de caja en la sección de Objeto/Editando Puntos (Object/Point Editing).
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Usted puede convertir una Malla en una subdivisión de objetos con el comando
Build->ConvertToSubdivided. Puede editar la Subdivisión como mallas regulares, pero son
automáticamente subdivididas cuando usted trabaja. Es una manera más fácil de modelar que la
aplicación continua de operaciones de subdivisión tratando de ver como lucirá eventualmente su
modelo. Las caras seleccionadas se muestran como ventanas transparentes revelando un modelo
refinado interior.

Cuando usted cambia el tamaño o extruye una cara la vista del suavizado interior cambia la forma
para seguir. (Usted solo aprecia esta vista en el Editor de Puntos. Todos los otros lugares de su
modelo se mostrarán como imágenes completamente subdivididas).

Puede convertir una Subdivisión objeto en una Malla con el comando Build->ConvertToMesh Esto
convertirá al nivel de la subdivisión que está usando para verla en las vistas de trabajo.

Otra muy importante ventaja de objetos Subdivididos es el tamaño. Las subdivisiones de objetos son
guardadas en un formato indiviso que es varias veces menor que el modelo final completamente
dividido Puede controlar el nivel de las subdivisiones usadas en la pantalla y en la imagen final
cliqueando dos veces y editando el diálogo de propiedades.

This page was last updated on February 19, 2001. Copyright 2001 R. Steven Glanville
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Subdivisión de Objetos



 

4. Editor de Objetos
Objeto/Modo Punto

El botón  Objeto/Punto   en la barra de herramientas, cambia Anim8or al modo de edición de
puntos del objeto. Aquí puede modificar puntos individuales, aristas, y caras de cualquier objeto
malla. Puede mover, escalar, rotar, agregar y borrarlos. Puede extruir, torcer, y escalar caras, soldar
puntos próximos, etc. Cuando entra en el modo de Edición de Puntos, lo mostrado cambia
automáticamente a modo alambre. Si quiere ver los objetos como sólidos, use el ítem de menú
View->Full.

Inmediatamente abajo de la fila de botones de ejes coordenados, hay una nueva fila con estos tres

botones: 

Use estos botones para cambiar el modo selección entre punto (point), arista (edge), o cara (face)

para seleccionar diferentes partes de su modelo. Los modos seleccionar   y seleccionar por

arrastre   seleccionarán los correspondientes ítems.

 

Editando Puntos

Usted usa el modo edición de puntos  para modificar la forma de un objeto, y agregar y borrar
partes de un objeto.

Puede manipular los puntos seleccionados usando los botones mover, rotar y escalar. Las
operaciones de rotar y escalar se hacen con relación a los puntos de  pivot de los objetos.

Si usted borra cualquier punto usando el botón de tijera (scissors) , cualquier arista o cara que
contenga este punto se borra también. Por ejemplo, para borrar la parte inferior de la esfera, primero
seleccione los puntos de la parte inferior usando la herramienta de seleccionar arrastrando, pero sin
incluir el ecuador, y corte.

Anim8or Basics



Si usted mueve   estos mismos puntos, escalándolos no uniformemente  , o escalándolos

uniformemente  , puede hacer que los objetos se vean así:

Usted puede usar las flechas del teclado para hacer movimientos pequeños, rotaciones, y escalar los
puntos seleccionados tan pronto como sea seleccionado el correspondiente botón de la barra de
herramientas.

 

Editando Aristas

Usted usa el modo editar arista   de manera similar al de edición de puntos. Cuando selecciona
una arista, selecciona también los puntos extremos. Así, todas las operaciones del modo punto son
habilitadas como se describe arriba.

Si borra usando las tijeras en el modo arista, sin embargo, se borran solo las aristas y caras que las
contienen. Todos los puntos son salvados. Esto le permite cambiar la trama (tessellation) de un
objeto más fácilmente, sin tener que agregar puntos previamente borrados.

Puede fijar también varias propiedades de arista (edgeproperties) en aristas seleccionadas.
Seleccione la arista que  busca modificar y luego elija el ítem de menú edit->edge_properties. El
valor por defecto para aristas es suavizado (smooth).  Esto significa que si el ángulo sólido definido
por las dos caras es menor que cierto umbral, la arista se verá suavizada. De otra manera, se verá
como un pliegue. Puede cambiar el valor de este ángulo haciendo doble clic en la malla para abrir el
cuadro de diálogo de parámetros cuando se halle en el modo Objeto/Editar.
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Puede marcar una arista como plegado (creased) en una superficie suavizada, de esta manera se
mostrará como una forma facetada. Esto no cambia la geometría del modelo de ninguna manera,
simplemente la forma normal es procesada para aparecer suavizada o plegada. La esfera siguiente
tiene la mitad inferior de sus aristas marcadas como plegadas:

Otra propiedad que se puede fijar en ese diálogo es cuán redondeadas (rounded) serán las aristas
cuando estén suavizadas. Normalmente cuando se suaviza una malla, todas las aristas se suavizan.
Cada aplicación de suavizado, incrementa el número de caras en la malla, y suaviza todas las
aristas. Usted puede marcar cualquier arista para que no se suavice, pero retendrá su forma de
plegado, por uno o más ciclos de suavizado. Lo siguiente muestra un cubo y varios posibles
suavizados en él:

La esfera que se ve como pelota es el resultado de aplicar a un cubo varios suavizados. Los dos
cubos redondeados de arriba son el resultado de suavizar un cubo con un redondeado de nivel 1 y 2
en todas sus aristas. Los dos cilindros redondeados de abajo vienen de un cubo con solo las 4
aristas superiores y las 4 aristas inferiores seleccionadas y un redondeado de 1 y 2.

 

Editando Caras

Usted usa el modo editar cara (edit face)  para seleccionar y manipular las caras de una malla.
Puede borrar las caras seleccionadas con el botón tijera, pero los puntos y aristas permanecerán sin
cambio. No puede mover, rotar o escalar las caras seleccionadas. Puede aplicar estos cambios sólo
a los puntos seleccionados (y líneas). Esto es porque hay ambigüedad sobre lo que piensa hacer
ciando selecciona varias caras adyacentes. Sin embargo hay caminos alternativos para manipular
caras, lo que se describe más abajo.
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Las caras seleccionadas se muestran llenas incluso en modo de malla de alambre. El lado frontal
está sombreado en amarillo y el lado de atrás en azul para ayudar a ver las caras seleccionadas.
Este es también el caso de modo relleno, pero normalmente sólo verá el amarillo de las del frente.

 

Aplicando Múltiples Materiales
Puede también aplicar diferentes propiedades de materiales a caras individuales. Simplemente
seleccione las caras que busca cambiar, despliegue la barra de herramientas de materiales (use
options->materials si no está visible), seleccione el material a aplicar, y haga clic en el botón

aplicar   en la barra de herramientas.

Puede usar tantos materiales como quiera en una malla. Con un poco de imaginación, puede hacer
objetos como estos.

La herramienta de textura UV está disponible en el Editor de Punto. Primero seleccione las caras a
las que aplicará textura, entonces use la herramienta UV para aplicar las coordenadas
interactivamente. Esto lo ayudará si ya tiene un material texturado aplicado a estas caras.

 

Nota en Seleccionando Caras
A veces puede ser bastante tedioso seleccionar las caras exactas que usted desea, especialmente
en un modelo complejo. Pero hay varios trucos que pueden ayudarlo.
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El modo selección (select)  selecciona aquellas caras que están al frente por sobre las que se
encuentran detrás. Puede ayudar el cambiar las vista de un objeto o cambiar temporalmente a modo
edición de objeto y rotarlo para que las diferentes caras queden adelante. Esta es una razón para
seleccionar las caras que se muestran en amarillo incluso en las vistas normales donde realmente
no puede hacer nada a caras individuales.

El modo de selección por arrastre (drag select)  sólo selecciona caras que se encuentran
dentro del rectángulo. Así usted puede a menudo agregar caras una a una hasta que haya elegido
las que necesita.

 

Agregando Puntos y Aristas

Puede agregar nuevos puntos y aristas al modelo con al botón Agregar Puntos   

Para agregar cosas a un objeto existente, cliquee en uno de sus puntos y arrastre el mouse hacia
afuera. Se agregará una nueva arista y punto donde suelte el botón del mouse. Si necesita moverlo
sobre un punto existente, entonces el extremo de la arista se pegará al existente, y la arista se
agregará  entre los dos puntos. Puede hacer mallas complejas rápidamente usando este método:

Si quiere agregar un punto que está cerca de otro pero no que sea el mismo punto, apriete la tecla
Shift después de pulsar el motón del mouse y manténgalo hasta que suelte el mouse.

Si quiere empezar una nueva malla, presione la tecla Shift antes de accionar el botón del mouse Se
creará una nueva malla con una arista simple y 2 puntos.

Nota: Este comando sólo agrega Puntos y Aristas, no Caras. Puede usar el comando
Edit->FillHoles que se describe más abajo para agregar caras nuevas.

Si habilita pegar a la grilla (snap-to-grid) cuando usted agrega puntos, puede construir objetos con
medidas exactas más fácilmente.

 

Agregando Caras
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Una vez que haya agregado nuevas aristas a una malla, le será posible llenar los huecos con nuevas
caras. Usted hace esto seleccionando primeramente las aristas que rodearán la nueva
cara. Entonces use el comando Edit->FillHoles para llenarla.

 Hay algunas pocas cosas a tener en cuenta antes de empezar a
agregar caras:

Las Caras sólo pueden agregarse a aristas conectadas en un
perímetro cerrado. Si hay algún hueco, no se agregará ninguna
cara.

●   

Ninguna de las aristas del perímetro pueden ser parte de dos (o
más) caras. Se considerarán aristas que son parte de a lo sumo
una cara. Usted puede decir cuantas aristas participan por su
color cuando son seleccionadas.

●   

Puede seleccionar una cantidad de aristas y crear todas las
caras al mismo tiempo.  Anim8or empezará llenando cualquier
perímetro de aristas que se complete con 3. Entonces llenará
todos los perímetros que se completen con 4, etc. hasta que no
se puedan agregar más caras. Esto a veces origina resultados
no deseados y debe tratarse de nuevo con menor cantidad de
huecos.

●   

Puede tener que aplicar los comandos Edit->FlipNormals  y
Edit->FixNormals para orientar adecuadamente las nuevas
caras después de agregarlas.

●   

Color de la
Arista

Número de
Aristas

ROJO Ninguna
VERDE Una

BLANCO Dos
VIOLETA Tres o Más

Usted puede tener que borrar algunas caras en su malla abnes de agregar nuevas donde lo
necesite.

   

Conectando Mallas
Puede conectar dos mallas separadas para crear una simple, conéctelas usando los comandos
JoinSolids, Add Points/Edges y Add Faces.

Primero posicione cerca una de otra las dos mallas que quiere conectar. Deje un pequeño
hueco para la fila de nuevas caras que se usarán para conectarlas.

●   

En el Editor de Objetos, seleccione ambas mallas y aplique el comando
Build->JoinSolids. Esto no agrega ninguna cara de conexión, pero las combina en una Malla
simple que permite hacerlo.

●   

Luego en el Editor de Puntos, agregue nuevas aristas entre los pares de puntos que quiere
conectar.

●   

Seleccione todas las aristas que recién agregó, y todas las vecinas.●   

Use el comando Edit->FillHoles para agregar las caras de conexión.●   
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Fusionando Puntos
Usted puede fusionar puntos separaos en uno solo mediante el comando Edit->MergePoints.
Primero seleccione los puntos que busca fusionar. Es mejor si se encuentran muy cerca uno del otro.
Entonces aplique el comando Edit->MergePoints. Aparecerá un diálogo donde podrá entrar la
distancia máxima permitida entre pares de puntos. Cliquee OK y los pares de puntos elegibles se
fusionarán,

Conectando Mallas (2)

Puede usar esta técnica también para conectar dos mallas. Esto trabaja mejor si se están
conectando puntos similares en cantidad y tamaño. Por ejemplo conectando la mitad de una Esfera
que tiene 12 cuerdas con un Cilindro con 12 generatrices.

Conectando Mallas (3)

Puede a menudo construir la mitad de un objeto simétrico, luego reflejarlo con Build->Mirror, y
combinar las dos mitades en una malla simple con Build->JoinSolids. Luego posicione las dos
mitades muy juntas, seleccione los puntos adyacentes y use Edit->MergePoints en el Editor de
Puntos para hacer una conexión sin costura. El objeto fusionado tendrá suavizada una vez las
esquinas.

 

Parámetros de Punto y Línea

   

Cuando se encuentra en modo Punto 
puede hacer doble clic en un punto y abrir y abrir
un cuadro de diálogo que le permite asignarle su
posición numéricamente.
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Cuando está en modo Arista   puede de
manera similar hacer doble clic en una arista
para editar sus propiedades.

   

Extrusión de Caras y Herramientas de Manipulación
Puede manipular las caras seleccionadas en una variedad de formas usando el grupo inferior de
botones de la barra de herramientas. Pueden ser usados para hacer modelos muy complejos  de
pequeño número de formas cúbicas usando el método de  modelado de cajas.

Use este botón pare extruir (extrude) todas las caras seleccionadas. Cada cara se traslada
en la dirección que enfrenta, hacia dentro o hacia afuera, y se agregan nuevos polígonos
para conectar las caras con sus aristas originales.

Similarmente a la herramienta de extrusión, la herramienta de extruir conectado (extrude
connected) extruye caras seleccionadas en una Malla. Sin embargo las caras adyacentes
seleccionadas permanecen conectadas. Se agregan caras nuevas sólo a las aristas entre 

las caras seleccionadas y las no seleccionadas. 

 Las 6 caras en el sólido de la izquierda se
muestran arriba extruidas, y estruidas conectadas.

Este botón rota (rotate) cada cara seleccionada alrededor de su centro. Es muy útil ciando
las caras seleccionadas no son adyacentes
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Puede escalar (scale) caras seleccionadas con este botón.

Este reemplaza caras con un pico (peak). 

La herramienta de biselado (bevel) es útil para agregar esquinas facetadas a una superficie.
Puede biselar caras y aristas de cualquier malla. Las aristas seleccionadas son
transformadas en nuevas caras, cortando las esquinas del modelo original como se muestra
abajo:

Las caras seleccionadas se manipulan como un grupo. Las aristas entre las caras
seleccionadas y las no seleccionadas son biseladas pero las aristas entre dos adyacentes
seleccionadas se mantiene.
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La herramienta intercalar (inset) se usa también para agregar caras a uns superficie. Cada
cara seleccionada es reemplazada por una versión más pequeña de la misma y conectada
por nuevas caras a sus aristas originales. Es una manera muy rápida de agregar detalles a
una porción particular de un modelo, o hacer un hueco para una puerta, ventana, u ojos.

Cuando usa estas operaciones de manipulación de caras usted puede continuar con una o más
aplicaciones de el operador  subdividir para construir formas más complejas. Por ejemplo, empezar
con un pentágono extruido, seleccionar sus 5 caras externas, extruirlas, y suavizarlas para hacer una
estrella de mar:

Comandos de Edición de Cara
Anim8or tiene otros comandos útiles de edición de caras. Los encontrará bajo el menú Editar en
Edición de Puntos.
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El comando puente (bridge) permite varias operaciones útiles. Para usarlo primero seleccione dos
caras diferentes. Ellas deben tener el mismo número de aristas pero pueden pertenecer a Mallas
diferentes si lo desea. El comando Edit->Bridge entonces conectará las dos caras seleccionadas
con nuevas caras, conectando cada arista de una cara con la correspondiente arista de la otra cara.
Puede fabricar hoyos a través de una Malla:

Puede conectar dos partes de una malla para formar un puente:

Y puede unir dos Mallas diferentes en una malla simple:

La operación remueve las caras originales seleccionadas para guardar adecuadamente las Mallas
formadas.

El comando aplanar (flatten) hace lo que su nombre sugiere: aplana grupos de caras seleccionadas.
Los vértices de cada grupo se proyectan sobre un plano. Usted puede elegir entre la dirección del
grupo promedio de caras o las de los ejes X, Y, o Z. EL aplanamiento es muy útil cuando  necesita
un nivel o base para un modelo, y puede usarlo con el comando fundir caras para ayudarse a
simplificar sus modelos.
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El comando fundir caras (merge faces) combina grupos de caras seleccionadas en una cara simple.
Puede simplificar áreas muy detalladas de sus modelos por este camino.

Debe ser cuidadoso con las caras convexas y relativamente planas o no podrán ser renderizadas
apropiadamente. Las caras convexas son aquellas que no tienen ningún punto dentro de su límite
exterior o contorno aparente. Las caras con puntos interiores se llaman cóncavas y pueden causar
errores de rendering:

En el ejemplo mostrado arriba se funden tres caras pentagonales en una gran cara de 9 lados. Es
cóncava y no se puede tener un resultado apropiado. Es fácil de ver en este ejemplo porque la parte
de atrás de las caras son azules cuando están seleccionadas. Otras veces es posible que no sea tan
obvio el error.

Si está trabajando con Subdivisión de objetos no es tan importante. Las caras que está editando no
se verán en el dibujarán en el objeto final. La subdivisión suavizará la malla haciendo que se vea
mejor formada.

 

This page was last updated on March 28, 2001. Copyright 2001 R. Steven Glanville
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5. Editor de Figuras
El editor de figuras (figure editor) es donde usted designa los personajes animados para ponerlos
en las escenas de Anim8or. La principal diferencia entre la figura y un objeto ordinario es que la
figura contiene una estructura de huesos (bone), o esqueleto, que usted puede doblar y formar en
diferentes poses. Poniendo estas poses del personaje en unas pocos cuadros clave (key frames) de
la animación, puede darle vida.  Anim8or rellenará los cuadros entre las poses moviendo lo
necesario las articulaciones del esqueleto. Puede  ingresar al editor de figuras en cualquier momento
seleccionando Mode->Figure en el menú.

La pantalla básica es similar a la del Editor de Objetos y se muestra abajo. Puede ver múltiples
puntos de vista simultáneamente como en los otros editores.

Note que los huesos son un poco visibles dentro del cuerpo y piernas del personaje. Puede controlar
la visibilidad de los huesos, las partes del cuerpo del personaje, y otros aspectos que lo ayudarán
con el diseño. Este personaje no tiene huesos particularmente interesantes en el cuerpo, pero tiene
piernas y pies animables.

El editor de figuras tiene dos modos: editar (edit) y puntodevista (viewpoint). Puede cliquear en uno
de los íconos para cambiar entre los dos modos.

Botón de modo Figure/Edit. Este es el modo en que se inicia el editor de figuras. Lo usa para
hacer todo lo relativo al diseño de su personaje.

El modo Figure/Viewpoint le permite visión panorámica, escalar, rotar y ajustar a la ventana
las vistas de su espacio de trabajo.
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Básico en Figuras
Hay dos partes diferentes que usted hace cuando construye una figura:el cuerpo (bodie) que es lo
que conforma todas las partes visibles de su personaje que aparecerán en las imágenes finales, y
los huesos (bones) o esqueleto (skeleton) que los usa para animar su personaje.

Usted normalmente diseñará todas las partes del cuerpo de su personaje como
objetos, en el Editor de Objetos. Cuando los agrega a su personaje, sólo hará
referencia a los objetos originales. Esta es la manera de agregar un objeto varias
veces sin incrementar el tamaño de los archivos de trabajo, y hacer cambios en
cualquier instancia mediante la edición de los objetos.

Hay también un par de formas "pre hechas" en el editor de figuras para ayudarlo
con sus diseños preliminares y pruebas de movimiento. Las piernas de "pelota y
el palo" mostrados aquí están hechas  con cilindros y pelotas.

Una vez que ha hecho las partes de su personaje, debe cambiar al Editor de Figuras y
construir el esqueleto. Empezando con el hueso principal o raíz, agregará un hueso a
la vez para hacer la estructura móvil del personaje. Por ejemplo, si busca algo como
puernas humanas, necesitará agregar huesos para la parte superior, inferior y pié.
Puede dar a cada articulación su propio rango de movimiento, lo que facilita mucho la
animación.

Cuando el esqueleto esté diseñado, puede agregarle al personaje las partes
visibles. Usted relacionará cada parte con un hueso específico, y cuando se
mueva el hueso, lo hará la correspondiente parte del cuerpo. Puede también
mover, escalar y rotar cada parte individualmente dentro de las coordenadas
de espacio de su hueso.

   

Figura/Operaciones de Edición
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Usará el primer grupo de botones para seleccionar las partes de su personaje, y poner las partes
visibles en los huesos de manera similar al Editor de Objetos.

Usará este modo para seleccionar (select) huesos y partes del cuerpo de  su personaje.
Como es usual, puede usar el botón derecho de su mouse para seleccionar cosas
adicionales mientras mantiene las originalmente seleccionadas.

Este botón habilita el modo arrastrar-seleccionar (drag-select). Puede arrastrar un
rectángulo en la pantalla y seleccionar objetos que caen dentro de su área. Nuevamente
usando el botón derecho del mouse agregará selecciones sin deshacer ninguna.

Los próximos tres botones se aplican a los objetos que están unidos al esqueleto, no a los
huesos mismos. Use este para mover (move) un objeto con relación al hueso al que está
unido.

Puede rotar (rotate) objetos con este botón, y

escalar (scale) objetos con éste. Usted debe seleccionar un objeto antes de poder
modificarlo.

Use el próximo conjunto de botones para editar los huesos del esqueleto de su personaje una vez
que se ha construido. 

Este modo le permite rotar (rotate) las articulaciones de su personaje a su posición
nominal. Esta posición define el valor cero para todas las rotaciones que esa articulación
puede tener. No es lo mismo que la posición por defecto (default) de la articulación, que es
la posición "relajada" de la articulación, sino que se usa para establecer un sistema de
coordenadas del hueso.

Usted usa este botón para cambiar el largo (length) de los huesos. Cuando es accionado,
puede hacer clic en el final del hueso seleccionado y alargarlo o acortarlo con el mouse.
Debe estar seguro de cliquear al final del hueso o no cambiará. También puede hacer doble
clic en un hueso y fijar el largo directamente con el cuadro de diálogo.

Use este modo para agregar (add) nuevos huesos al esqueleto. Para agregar nuevos
huesos conectados, haga clic en el final (end) de un hueso y arrastre para fijar su largo.
Siempre se alineará en la misma dirección que su padre. Así, si quiere orientarlo en otra
dirección, debe usar el botón de rotación mostrado arriba.

Nota: Debe hacer clic en la punta (tip) del hueso o nada sucederá. Si quiere juntar un nuevo
hueso al final de uno sin seleccionar, haga clic en la punta y será seleccionado. Luego haga
clic una segunda vez en la punta, y arrastre hasta que su nuevo hueso tenga el largo
correcto. Puede también hacer doble clic en un hueso para desplegar el cuadro de diálogo
de sus parámetros y fijar su largo manualmente.

Este botón le permite vestir (skin) parte o todo el esqueleto con un Objeto simple. Luego
cuando las articulaciones del hueso doblen el objeto de deforma de manera similar a lo largo
de su esqueleto. Hay más detalles sobre como usar esta herramienta más adelante.

Use el grupo final de botones para controlar qué es visible en la ventana de edición. Puede encontrar
muy fácil de manipular el esqueleto de su personaje sin que interfiera el cuerpo en el camino, o
buscar ver el resultado final sin mostrar los huesos. Estos controles hacen sólo eso.
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Usted usa estos dos botones para cambiar entre la  visibilidad (visibility) de los huesos y
partes del cuerpo. Si ambos están habilitados, entonces el cuerpo del personaje se mostrará
semitransparente con los huesos adentro. Esto es indispensable cuando coloca las partes
del cuerpo. Si sólo uno está seleccionado, el ítem correspondiente se muestra como objeto
sólido. 

Esto muestra un personaje con su esqueleto simple. Sólo las piernas tienen huesos, asi que
sólo podrá animar las piernas. La cara se congelaría con esa mirada a menús que usted le
agregara huesos para animar los ojos, alas, pico, etc.

Este botón cambia entre los ejes (axis) visibles para cualquier hueso seleccionado. También
le muestra el rango de movimiento de sus articulaciones.

   

Construyendo un Esqueleto

Cada esqueleto de un personaje empieza con un hueso raíz (root) . Mediante el agregado de
huesos hijos (child) a la raíz, y de sucesivos huesos, usted construye el esqueleto un hueso a la vez.
Cada hueso el poseído (owned) por su padre (parent), y cualquier movimiento que el padre haga
también moverá a todos sus hijos.

Cuando usted agrega un hueso, este se alinea en la misma dirección que su padre. Asín
normalmente usted tiene que rotarlo a su propia orientación.

Si busca borrar (delete) un hueso, primero selecciónelo y luego elija Edit->Cut de la barra de menú.
Esto borrará el hueso y todos los objetos unidos a él.  Cualquier hueso inferior se moverá y unirá al
padre del hueso borrado.
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Este es un simple esqueleto. Está hecho con 9 huesos más el raíz. El esqueleto
está construido con dos caderas y piernas simétricas. Los dos huesos inferiores en
la pierna izquierda se ven seleccionados y se muestran en blanco.

El pié tiene visible un diamante   extra en su final. Esto le brinda una más fácil
selección cuando está manipulando el hueso. La pierna inferior también tiene uno,
pero no es visible al estar dentro del hueso del pié.

   

Articulaciones Flexibles
En Anim8or usted decide cuales
articulaciones son flexibles y cuales se
congelan en una posición fija. Por defecto
son fijas. Usted agrega flexibilidad en el
cuadro de diálogo del editor de huesos que
aparece cuando hace doble clic en un
hueso.

Usted controla la rotación de la articulación
alrededor de cada eje independientemente.
Haciendo clic en la casilla "libre" (free)
para un eje le permite rotarlo alrededor de
ese eje. Puede fijar los ángulos mínimo,
por defecto (default) y máximo permitidos..

Los ángulos se limitan a valores entre -359
y 359 grados con una máxima diferencia de
359 grados.

Usted usa los ejes X y Z para controlar la inclinación de una articulación, y el eje Y para torcerla
alrededor de él. Haciendo clic en la casilla "Bloqueado" (Locked) prevendrá cualquier cambio en el
largo o posición del hueso en un esqueleto básico. Esto es una buena idea para bloquear sus
huesos una vez que ha terminado de poner en orden las cosas. Esto previene su accidental
alteración. Usted puede cambiar todavía los parámetros de la articulación, pero esto se hace desde
el cuadro de diálogo, no con el mouse. Las casillas "Bolqueadas" para cada eje se usan cuando está
animando un personaje y no aplica el editor de figuras. 

Si usted marca la casilla "Sin Límites" (No Limits), entonces le será posible rotar el hueso libremente
en ese eje. Esta clase de articulación es llamada libre (free) o irrestricta (unconstrained) por no
tener límites en su posición.

Anim8or Basics



Este es un costado del esqueleto. El botón de mostrar ejes  esta fijo
para que usted pueda ver los límites de rotación de la articulación de
cualquier hueso seleccionado. El eje x se muestra en verde, el eje y en
azul, y el eje z en violeta.

El eje seleccionado aquí es la parte inferior de la pierna derecha y forma la
rodilla derecha. Esta sólo puede doblarse hacia atrás en el eje-x y como la
rodilla humana, en este caso un máximo de 135 grados.

   

Agregando Partes del Cuerpo

Una vez que ha construido el esqueleto, usted necesita agregar las
partes visibles del cuerpo que aparecerán en las imágenes finales.
Cada parte del cuerpo es un objeto que usted agrega a un específico
sistema local de coordenadas de un hueso. Primero seleccione el
hueso al que le quiere agregar su objeto, entonces use el comando
de menú Build->AddObject para agregarlo. Su objeto se comporta
entonces como ese hueso. Cuando el hueso rota, lo hace el objeto.

Puede agregar también simples cilindros y esferas. Ellos no son muy
sofisticados, se ven como palos y pelotas, pero permitirán que realice
rápidas pruebas para ver cómo se comporta el esqueleto. Usted los
agrega usando los menúes Build->AddCylinder y
Build->AddSphere.

Puede cambiar algunas de las propiedades de estas formas
simplesl. Haga doble clic en uno para abrir su diálogo de
propiedades, y use el menú Settings->Component->Material para
fijar su color. Estas formas básicas no son flexibles como los Objetos
que usted mismo construye. Ellos tienen algunos límites bastante
restrictivos y no son adecuados para un rendering final. Para un más
fino control de estas cosas usted necesita hacer cosas en el Editor de
Objetos.

   

Vistiendo
En la sección previa usted ha aprendido, cómo agregar un Objeto como pariente de un hueso
específico. Este sigue todos los movimientos de su hueso padre, pero permanece como un rígido e
inflexible Objeto. Esto es lo que usted busca cuando construye un robot.  No es exactamente lo que
hace un ser humano o animal. Usted busca que se vea flexible, que cambien de forma y se doblen
con su esqueleto. Esto es exactamente lo que la Vestimenta (Skinning) hace.

Anim8or Basics



Una vez que ha construido un Objeto y su esqueleto, puede agregar su
objeto a varios huesos al mismo tiempo con la herramienta Skinning. De esta
manera cada hueso tiene un área de influencia que es más fuerte cerca del
hueso y disminuye hacia el exterior. Cada punto en el objeto se mueve con
cada hueso cercano, proporcionalmente a la fuerza de la influencia que ese
hueso tenga en él.

Los dos huesos de la derecha muestran sus rangos de influencia. El área
amarilla interior es donde el hueso ejerce su máximo control. Esto no
significa que otros huesos no puedan también controlar puntos dentro de esa
región, sólo muestra dónde el hueso tiene una fuerte influencia. El área
exterior naranja es el límite de control del hueso. Los puntos que quedan más
allá de la zona de influencia no son afectados por el hueso. La única
excepción es que si el punto queda fuera de todas las zonas de influencia de
los huesos, es simplemente controlado por su hueso base, aquél al que es
vinculado inicialmente.

Para vestir un objeto usted primero lo vinculará a un hueso llamado hueso
base. Usted deberá elegirlo cuidadosamente dado que sólo los huesos
descendientes podrán actuar sobre su objeto..Entonces entre en el modo Skinning
presionando el botón    de la barra de tareas.

Ahora seleccione su objeto haciendo clic sobre él. Esto habilitará que vista su objeto y
agregue su hueso base para establecer su zona de influencia, aquellos huesos que
pueden alterar su forma. Para agregar nuevos huesos, simplemente cliquee en ellos y
confirme que busca agregarlos en el diálogo que aparezca.

Usted puede ajustar el tamaño de la influencia
de los huesos de dos maneras. Puede hacer
doble clic en él y entrar valores numéricos, o
puede editar la zona de influencia directamente
el la pantalla.

Usted puede fijar el rango interior y exterior de
influencia para el principio y final de cada hueso.
Puede también fijar la posición a lo largo del
hueso donde empiezan y terminan como
porcentajes del largo del hueso.

Cambiar los tamaños directamente en la pantalla
es a menudo más eficaz pero esto puede ser a
veces falso porque las cosas se desordenan con
varias regiones solapadas.

Hay seis puntos de control en cada hueso, tres en cada extremo. Si deshabilita la visibilidad de los
huesos y objetos cliqueando en los botones al final de la barra de herramientas, tendrá una
representación clara de ellos. Use el de la punta del área anaranjada para ajustar el tamaño de la
región exterior, y el de la punta de la zona amarilla para la interior. El punto amarillo interno ajusta el
desplazamiento.
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Una nota final:  No trate de ajustar la posición de sus huesos en el Editor de Figuras y tratar de ver la
malla doblada!  Esto no trabaja así. Usted sólo estará ajustando la posición del hueso, y área de
influencia, relativa a su objeto. Deberá ir al editor de Secuencia para empezar a animar su personaje.

   

Ahora usted está listo para ir el Editor de Secuencia (Sequence Editor) para hacer algunas
secuencias animadas. Entonces al Editor de Escenas (Scene Editor) para su película final!

 

This page was last updated on September 1, 2001. Copyright 2001 R. Steven Glanville

Anim8or Basics



 

6. Editor de Secuencias
El Editor de Secienciac (Sequence Editor) es donde usted verá los movimientos que le darán
personalidad y estilo a su personaje. Una secuencia (sequence) es un pequeño bloque de poses de
cuadros clave, como un ciclo de caminata. La manera más fácil en la que usted puede animar una
figura es poniéndola en una escena y agregando una o más secuencias.

Largas animaciones pueden hacerse de varias pequeñas secuencias, como construir una larga
caminata haciendo múltiples aplicaciones de un ciclo de caminata. Las secuencias adyacentes se
unen automáticamente en una simple de movimiento suave por Anim8or, usando las posiciones de
los cuadros clave como guías. Aquí hay un pantallazo del Editor de Secuencias en acción:

 

Pista de Tiempo
La pista de tiempo (time track) en la base del Editor de Secuencias indica el cuadro actual que se
muestra en la ventana. Los cuadros que tienen una o más articulaciones en posiciones importantes
se marcan en él con un pequeño cuadrado negro  . Los números :01 muestran el tiempo en
segundos desde el inicio de la Secuencia, de una posición en la pista. El cuadro actual se resalta con
un fondo gris oscuro.

Puede expandir la pista para ver un árbol mostrando detalles de las claves de las articulaciones
individuales cliqueando en el signo más   al lado del título.
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Las posiciones clave se muestran para cada par de articulación/ángulo con un pequeño cuadrado
negro en el cuadro. Puede también seleccionar una articulación haciendo clic en ella en la pista
expandida. Cambie el tamaño de la pista expandida cliqueando y arrastrando arriba o abajo la barra
vertical  , abajo de la barra de herramientas.

La pista se desplazará automáticamente para mantener el cuadro actual visible cuando la secuencia
es muy larga para mostrar todo de una vez. Si busca ver un cuadro que no está en la ventana, puede
elegir entre usar el comando Settings->Sequence para poner el cuadro numéricamente o puede
usar las flechas Izquierda y Derecha del teclado para pasar la secuencia hacia adelante o hacia atrás
hasta alcanzar su marco.

Puede moverse hasta un cuadro particular en una secuencia cliqueando en ese cuadro en la pista. Si
usted cliquea y arrastra el mouse seleccionará un rango de cuadros. Cliqueando en el nombre del
hueso lo selecciona y resalta en la ventana de la pista. Cliqueando en el título de la secuencia
selecciona todos los huesos. Los botones del Mouse tienen su significado habitual en los nombres
de los huesos: el derecho agrega a la selección, y el del medio sustrae. Use Shift-Click para
seleccionar un rango de cuadros mientras mantiene un cuadro seleccionado.

 

Secuencias Básicas
Usted no puede animar un personaje antes de tener uno!  Así no debe sorprenderle que primero
debe diseñar un personaje en el Editor de Figuras antes de darle algún movimiento. Una vez que
tiene uno, puede cambiar al Editor de Secuencias y se creará una nueva secuencia en blanco.
Seleccione el ítem de menú Settings->Sequence para mostrar el diálogo de variables de la
Secuencia:
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Cliquee en el botón   y seleccione su personaje de la lista. Puede también fijar el número de
cuadros en la secuencia. Ahora su personaje aparecerá en las ventanas y podrá empezar a
animarlo. Puede también fijar con este diálogo la longitud de las Secuencias y fijar la vista actual a
un cuadro particular.

El editor de secuencias tiene dos modos: editar (edit) y puntodevista (viewpoint).  Usted puede
cliquear en uno de estos íconos para cambiar entre estos dos modos.

El modo Sequence/Edit es el modo inicial en que se inicia el editor de secuencias. Lo usa
para establecer todas las poses y para ver el movimiento por usted creado.

El modo Sequence/Viewpoint le permite vista panorámica, escalar, rotar, y ajustar a ventana
todas las vistas de su espacio de trabajo.

   

Operaciones de Edición
Use este botón para seleccionar (select) huesos en su personaje. El botón derecho le
permite seleccionar múltiples huesos.

Este botón le permite ajustar el ángulo (angle) de las articulaciones de su personaje a
nuevas posiciones para nuevos cuadros clave.

(este es el botón para InvertirMovimiento (InverseKinematics), una nueva manera para
posar y animar sus personajes. Desafortunadamente está deshabilitado. Seguramente
funcionará en la próxima versión...)

   

Opciones de Visibilidad
Este control le permite mostrar diferentes aspectos de su personaje en la pantalla cuando está
trabajando.

Este botón cambia la visibilidad de los ejes (axis) y el rengo de movimiento de cualquier
articulación seleccionada.

Estos botones controlan la visibilidad de huesos (bones) y partes del cuerpo (body parts)
de su personaje, como en el Editor de Figuras.

Use el botón de visión fantasma (ghost view) para mostrar múltiples cuadros o secuencias
superpuestas simultáneamente. Puede comparar poses clave previas e intermedias que
Anim8or crea con capas para ayudarlo a ver como encajan.

   

Butón Animar
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Este es el botón animar (animate). Esta es la varita mágica para hacer mover las cosas. Lo
usa para agregar y cambiar posiciones clave. Cuando cambia el ángulo de un hueso usted a
veces busca hacerlo para todos los cuadros en una secuencia, y a veces sólo en el cuadro
actual. El botón clave le brinda esta opción. Si no está presionado los cambios se aplican a la
secuencia entera. Si está presionado, sólo el cuadro actual se cambia. La próxima sección
explica esto con más detalle.

   

Qué es una Clave (Key)?
Si tuviera que poner la posición de cada articulación de su personaje en cada cuadro de la
animación, se pasaría la vida haciéndolo! Afortunadamente hay una manera más fácil de de animar
llamada cuadros clave (key frames). Con ella posiciona su personaje en unos pocos cuadros que
representan lo que debe estar haciendo en ese marco en particular, y la computadora rellena
suavemente los cuadros entre ellos. Usted conseguirá 'mejores resultados, naturalmente, si los
cuadros que elige representan puntos significativos en el movimiento de su carácter. Esto es el por
qué son llamados "clave" ("key").

No hay razón alguna para que todas las articulaciones tengan una clave en el mismo cuadro. Si su
personaje está caminando hacia adelante y mirando hacia atrás lentamente, usted puede querer
tener docenas de cuadros clave para la posición de las piernas, pero sólo uno para el movimiento de
la cabeza.

 

Haciendo una Pose Clave
Cuando usted crea primero una Secuencia, Su personaje se miestra en su posición por
defecto. Puede cambiar su posición doblando sus articulaciones. Pero sólo dobla aquellas que ha
hecho flexibles en el Editor de Figuras, y sólo de la manera que usted dijo que podían doblarse.

Para hacer una pose clave debe seleccionar primero la articulación
o articulaciones que quiere doblar. Mostrar los ejes e incluso
ocultar las partes del cuerpo puede ayudarlo. Entre en el modo

rotar Angulo  , habilite Animación  . Cliquee en la punta 
de la articulación y desplace el mouse para rotarla. Usted tiene que
escoger la articulación que va a rotarse, y tiene que usar el botón
correcto del mouse para usar el eje de rotación correcto.

Para rotar alrededor del eje X, que se muestra en verde,
use el botón izquierdo del mouse. La articulación tratará de
seguir al mouse.

●   

Para rotar alrededor del eje Y mostrado en azul use el
botón derecho. Dado que el eje Y rola la articulación
alrededor de la longitud del hueso, y no cambia la dirección
hacia donde está apuntando, usted tiene que mover el
mouse a izquierda o derecha para mover la articulación.

●   

Para rotar alrededor del eje Z mostrado en violeta, tiene
dos opciones. Puede usar el botón del medio del mouse si
tiene uno de 3 botones, o puede usar el botón izquierdo. Si
la articulación puede rotar alrededor de los ejes X y Z,
entonces debe deshabilitar primero el eje X. Haga doble clic
en el hueso y Bolquee (Lock) el eje X marcando la casilla

●   
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"Lckd" en la fila X, como se muestra abajo:

Y eso es todo! Usted ha creado una posición clave para una articulación. Para hacer que su
personaje se mueva, vaya a otro cuadro (cliquee en la ventana de la pista) y realice la segunda
posición clave. Cliquee en el botón play   para ver su movimiento.

Continué fijando las posiciones de las demás articulaciones que necesita cambiar hasta que esté
satisfecho con la pose.

 

Editando Cuadros Clave (Key Frames)
Puede editar los valores de los cuadros clave para articulaciones individuales. Haga doble clic en la
articulación en la vista expandida de la pista y aparecerá el diálogo editor del cuadro clave:
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El valor actual del ángulo de la articulación se
muestra al lado del rótulo value, y el cuadro
actual al lado del rótulo Frame No. Si este es un
cuadro clave para esta articulación le será
posible entrar un nuevo valor para esta clave, y
podrá borrar la clave con el botón Delete Key. Si
no es así, usted puede hacer esta clave con el
botón Add Key. Los botones más + y menos -
avanzan los cuadros de a uno en cualquier
dirección.

   

Un Círculo tiene 720 Grados
A veces la rotación no es tan simple como dar la
primera y última posición y dejar que la computadora
deduzca que hacer entre ellos. Para las articulaciones
constreñidas (constrained) (aquellas con límites en
cómo deben hacer la rotación). Para moverse de la
posición A a la posición B simplemente rote a la
derecha.

Sin embargo para una rotación libre (free) o no
constreñida (unconstrained) esto no trabaja. Hay dos
direcciones en las que la articulación puede moverse:
en sentido de las agujas del reloj o en sentido contrario.

Anim8or resuelve este dilema expandiendo el rengo de
ángulos que le es posible usar desde -360 grados
hasta +360 grados. Entonces hay dos valores para
representar la misma posición. Un cuarto de vuelta a la
derecha puede ser +90 o -270.  Si la diferencia entre
los ángulos es menor a 360 grados, la articulación
simplemente se mueve entre ellos. Si es mayor que
360 grados entonces la articulación se mueve en
sentido opuesto. Esto no es realmente confuso una vez
que lo ha usado un par de veces.

 

Haciendo una Secuencia

Anim8or Basics



Una Secuencia puede entenderse como un conjunto de Poses Clave reproducidas en orden.  Cada
posición de una articulación de un cuadro clave está vinculada a una posición anterior y posterior. La
posición entre claves de las articulaciones son llenadas por Anim8or. Cuando se ve de esta manera,
el personaje aparece ante sus ojos como si hiciera un movimiento continuo. La suavidad y la
velocidad del movimiento depende de cuan veloz y de que manera cambian las poses. Una gran
parte del trabajo de animación concierne a conseguir el movimiento correcto.

Después de que usted termine la primera pose clave, ponga la secuencia del cuadro posterior
haciendo clic en el lugar apropiado de la pista, o usando las teclas con flechas a izquierda y
derecha. Entonces haga la segunda pose clave. Usted no tiene que poner la posición de todas las
articulaciones, solo las que necesite. Si alguna parte de su personaje se está moviendo a paso lento,
o necesita menos control detallado, ahórrese algún trabajo.  Siempre podrá volver atrás y agregar
más claves si lo necesita.

Si tiene habilitada la Vista Fantasma   puede ver la posición
relativa de otros cuadros. Esto facilita ajustar cosas con respecto a
otras. Esta vista puede a veces causar confusión. Puede ayudarlo
el ocultar partes del cuerpo y animar el esqueleto.

Puede cambiar cuales cuadros se mostrarán como fantasma con el
comando Options->GhostSettings. Puede limitarse sólo a los
cuadros clave, o a aquellos que se designe aparte. Puede ajustar
también el número de cuadros fantasma mostrados.
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7. Editor de Escena
El Editor de Escena (Scene Editor) es donde usted construye el escenario (set), agregando objetos
y personajes, cámaras y luces, y construyendo sus escenas finales. Todo puede ser animado;
cámaras, luces, y personajes. Y usted puede guardar la salida como una secuencia pura de
imágenes, o como un archivo .avi. Puede generar también vistas stereo!  Usted entra al Editor de
Escenas desde el ítem de menú Mode->Scene.

Abajo se muestra el editor de escenas básico. Usted puede configurarlo para mostrar 4 vistas
cualquiera: frente (front), arriba (top), lado (side), y perspectiva (perspective), una simple vista de
estas, y vistas ortográfica (orthographic), o vista de la cámara. El menú, barra de herramientas, y
barra de estado están aquí, y la barra de pista muestra el cuadro actual.

 

Además de la selección normal, los botones de mover, rotar y escalar, tienen varias funciones
específicas para el editor de escena.

Usted usa el bloque de botones estilo VCR para controlar la reproducción de sus
escenas. Ellos trabajan de la manera usual.

El botón de eje (axis) hace visible los límites rotacionales y ejes de las articulaciones
cuando está animando las posiciones de las articulaciones.

Puede ocultar o mostrar los cuerpos de las figuras con el botón objetos figura (figure
objects). Esto puede hacer más rápida la edición de articulaciones.
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El botón cámara (camera) controla la visibilidad de su cámara y luces. Ellas no se
muestran el la vista de cámara, la que usted normalmente utiliza para renderizar las
escenas.

El botón camino (path) determina la visibilidad del camino de los objetos.

El botón clave (key) o animar (animate) habilita la animación. Cuando se presiona, los
cambios que hace a la locación, orientación, tamaño y otros aspectos del objeto en la
escena se animarán cuando reproduzca misma.

   

Elementos de una Escena
Un elemento es una parte de una escena. Una nueva escena contiene por defecto dos elementos, el
mundo (world) y la cámara (camera). El mundo es el sistema global de coordenadas. La locación y
orientación de todo en una escena es, finalmente, relativa al mundo. La cámara es el punto de vista
para las películas que usted hace. Usted no puede anular el mundo o la cámara.

Todo lo que usted puede agregar a la escena, incluyendo luces, objetos, figuras, y tablas, son
también llamados elementos.

 

Agregando Objetos
Usted agrega objetos a la escena seleccionando el ítem de menú Build->AddObject. Esto abre un
diálogo mostrando todos los objetos en su proyecto. Seleccione el que busca y haga clic en
OK. Será agregado en el centro de la escena. Este no es un objeto real; usted no puede editarlo
desde el editor de escena. En cambio es un eslabón (link) del objeto. Pero usted puede escalar la
vista de él en la escena, y agregar múltiples copias de él. El pantallazo de la escena de arriba tiene
tres instancias del objeto algas marinas en él.

Usted encontrará a menudo más útil seleccionar coordenadas mundiales (world coordinates) 

 cuando agrega objetos a la escena. Ellos se "dejan caer" en la escenaen el centro, en

las coordenadas <0,0,0>, y seleccionados. Esté seguro de que el botón   está habilitado, y
entonces podrá usar el botón izquierdo del mouse para arrastrar el nuevo objeto sobre el piso desde
cualquier pinto de vista. El botón derecho del mouse lo bajará o subirá. También puede escalar 

 y rotar   en un objeto tamaño y orientación, y animarlo especificando una serie de
cuadros clave (key frames).

 

Agregando Figuras
Usted agrega figuras en la misma manera con el ítem de menú Build->AddFigure. Ellos caen al
centro de la escena. Usted debe moverlos hasta su propio lugar. Puede animar la posición de las
figuras con cuadros clave, y puede adjuntar además secuencias predefinidas de movimiento, como
se describe debajo.
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La Cámara

La cámara  es el punto de referencia para el final de la animación. Es completamente
animable. Puede cambiar su posición, campo de visión, dirección, etc. Puede animarla para gran
variedad de alejamientos, inclinaciones o deslizamientos. Puede fijar la cámara a otro objeto en
movimiento mediante pistas de seguimiento, bloquear la dirección de una cámara en un movimiento
señalado, y también moverse a través de objetos "sólidos". Para ver lo que la cámara ve, seleccione
el ítem de menú View->Camera.

Actualmente Anim8or sólo soporta una cámara.

 

Luces
cuando usted crea una escena por primera vez, hay dos luces por defecto en ella. Ellas dan a la
escena el novel general de iluminación por lo que puede ver lo que está haciendo. Usted no las
puede mover o cambiar sus propiedades. En general usted podrá agregar sus propias luces para
mejor resultado.  Cuando lo hace, las luces por defecto se borran automáticamente.

Puede agregar luces a la escena mediante el ítem de menú Build->AddLight. Esto agrega una luz
directamente arriba con propiedades por defecto. Haga doble clic en ella para cambiar su color u
otros atributos, y arrástrela alrededor de la escena para cambiar su posición y dirección.

Como otras clases de objetos, las luces son completamente animables, incluyendo su color.

Hay tres clases de luces que puede usar en Anim8or:

Luz Infinita o direccional iluminan todos los objetos en la escena, con todos sus rayos
paralelos en la escena, como el sol. Las cosas cercanas o lejanas son iluminadas con el
mismo nivel de luz.

Luz Local emite luz que irradia en todas direcciones desde un punto particular de la
escena, como el bulbo de una lámpara. Los objetos entre la cámara y la luz están a
contraluz, mientras que los que están detrás de la luz están frontalmente
iluminados. Mientras más lejano está el objeto de la luz local, recibe menos iluminación de
esa luz.

Luz Spot es similar a la luz local, pero sólo iluminan objetos que se encuentran dentro de
un cono particular. Las cosas en el centro están completamente iluminadas, mientras que
las cosas cercanas al borde del cono son gradualmente menos iluminadas.

   

Las luces no aparecen en la escena final, o en una perspectiva o vista de cámara. Si usted quiere un
objeto que aparezca emitiendo luz, entonces debe agregar una luz en el mismo lugar del
objeto. Usted también puede cambiar la visibilidad de las luces en la otras vistas con el botón

mostrar cámara  .
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Nota: Sólo las luces direccionales son soportadas por el scaner del render (usado para salida de
archivo e impresora) por el momento.

 

Blancos (Targets)

Un blanco (target)   es un punto de referencia. Lo usa como punto de interés para que la cámara
lo siga, o como padre de un grupo de objetos que desea mover. Son totalmente animables, y no
aparecen en la escena final. Puede agregar un blanco con el ítem de menú Build->AddTarget.

 

Diálogo de Propiedades de Objeto

Puede editar varias propiedes de de cualquier
clase de elemento haciendo doble clic en él.
Esto abre un diálogo mostrado a la derecha
similar al del Editor de Objetos.

Puede animar cualquier valor que tenga un

botón controlador   a su lado, cambiando su
valor a través de la escena. Los valores con
fondo blanco son fijos para la escena. Usted
puede editarlos directamente en este
diálogo. Los valores que están grisados son
animados. Puede editar estos valores

cliqueando en el botón adyacente  .

Si usted busca animar un valor fijo, haga clic en
el botón para agregar un controlador. Los
Controladores se explican con más detalle más
adelante en este capítulo.
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Hay varios campos comunes para todos los tipos de elementos:

Name

(Nombre)

Es el nombre del elemento dentro de la escena. Recuerde, un objeto
elemento en la escena es sólo una referencia del objeto actual. Puede
haber más de un ejemplar del mismo objeto actual en la misma escena. Si
usted cambia el objeto original en el Editor de Objetos, entonces todas las
escenas también cambiarán.

Object

(Objeto)
El nombre del objeto actual. Puede seleccionar cualquier objeto en su
actual proyecto con el diálogo desplegable.

Location

(Ubicación)

Es la ubicación de un objeto en coordenadas <x,y,z>. Es la ubicación
relativa a la de sus padres y el sistema de coordenadas de sus
padres. Usted puede animar esta ubicación.

Parent

(Padre)

Cualquier elemento puede tener otro por su padre. Entonces cuando la
posición del padre cambia, los elementos cambiarán también. Con un
padre, la ubicación es una posición relativa. Para especificar un pariente
para un elemento, entre el nombre del padre en esta casilla. Para remover
el padre de un elemento, limpie la casilla o use el padre por defecto, la
palabra world.

Orientation

(Orientación)

Este valor muestra la orientación de sus elementos en grados de pitch,
yaw, y roll.  Pitch es la rotación alrededor del eje X, yaw el eje Y, y roll el
eje Z. Los valores mostrados son la orientación relativa a uno de los varios
sistemas de coordenadas. Puede ser relativo a su padre, su camino o
dirección de movimiento, a la orientación de otro elemento, o puede estar
siempre mirando a un elemento en particular. Usted puede animar la
orientación relativa.

Enable Roll

(Habilitar Rolido)

Usted puede deshabilitar el rolido de un elemento, manteniéndolo
"vertical".  Usted normalmente cuida que su cámara se mantenga firme, así
que por defecto cámara no puede rolar. Todo lo demás se puede. Habilitar
el roli puede animarse.

Visible También puede animar la visibilidad de los elementos para que pueda
aparecer o desaparecer durante la escena.

Editing
Properties

(Editando Propiedades)

Los valores del Editor de Propiedad son adecuados cuando edita su
escena. Puede ocultar (hide) un elemento cliqueando en la caja
"hide". Esto es útil para permitirle ver lo que hay detrás de algo, o
simplificar la escena para un dibujado más rápido. Para mostrar un
elemento oculto, desmarque la caja "hide", o seleccione el ítem de menú
Edit->ShowAll.

Usted puede bloquear (lock) un elemento marcando la casilla
"locked". Esto previene cualquier cambio de las propiedades en la escena,
como la ubicación o la orientación. Esto no significa que no pueda
moverse. Si está inicialmente animado, se conserva así. Bloquear sólo
previene de cambios accidentales en la animación.

Nota: Esto no significa que el elemento no puede cambiarse de ninguna
forma. Por ejemplo, si tiene un padre, entonces si cambia la ubicación del
padre, lo hará el elemento, dado que su ubicación es relativa a la del padre.
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Estos valores están presentes sólo para cierta clase de elementos.:

Scale El tamaño de un elemento puede animarse. A veces usted no puede usar el diálogo para

hacer esto. En lugar de ello, simplemente seleccione escalar  , habilite animación  , y
cambie el tamaño.

FOV Puede configurar y animar el campo de visión (fov or field of view) de la cámara, el ángulo
del ancho de la imagen que la cámara muestra en escena. Este valor está en grados.

Color Puede también animar el color o brillo de una luz.

   

La Pista de Tiempo
En la parte inferior de la ventana está la Pista de Tiempo (time track). Si no es visible en la pantalla,
seleccione el ítem de menú Options->TrackWindow:

A la izquierda está el título de la escena. Es la parte superior de un árbol descriptivo de los
elementos que componen la escena. Si hace clic en la caja "abrir" ("open")  puede expandir la
ventana para mostrar los objetos contenidos en la escena. Puede cambiar la altura de la pista
expandida arrastrando la barra de redimensión horizontal   arriba o abajo, y el ancho del

campo de nombre arrastrando la barra de redimensión vertical   a izquierda o derecha.

La parte derecha de la pista es una línea de tiempo de la escena. Si hace clic en ella, el display
cambiará al tiempo seleccionado. Cada marca gruesa representa un cuadro. Los segundos están
marcados con líneas verticales completas. Normalmente hay 24 cuadros/segundo pero usted puede
cambiar esto a otra velocidad de cuadro mediante el diálogo View->Preferences. El cuadro actual se
resalta con gris oscuro.

Puede hacer clic y arrastrar para seleccionar un rango de cuadros. Use Shift-Clic para seleccionar un
nuevo rango mientras mantiene la selección actual.

Cuando se expande, la parte izquierda de la pista muestra los objetos de su escena. Hay información
muy valiosa allí. Puede ver cuál es el padre de un objeto, qué propiedades se han animado, cuáles
huesos se han rotado. En la vista sobre el objeto resaltado shark1spot, su padre es el mundo. Su
ubicación es animada y tiene un objeto hijo llamado cookie. Si usted ve la caja "abierta"   en un ítem
quiere decir que hay más información disponible haciendo clic en la caja.
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Puede seleccionar y mostrar los ítems mostrados en la sección nombre de la pista haciendo clic y
doble clic en ellos. Los botones del Mouse tienen sus funciones normales, con el derecho se agrega
a la selección y el medio substrae. Haciendo doble clic es como puede editar el valor numérico de las
propiedades de animación como la escala de un elemento que no aparece en el diálogo.

 

Animación con Cuadros Clave (Key Frames)
Puede animar sus elementos simplemente moviéndolos en la pantalla. Primero habilite la animación

haciendo clic en el botón  . Su fondo se volverá verde   indicando que ahora está
animando. Cambie a un nuevo cuadro haciendo clic en un cuadro de la pista de tiempo.  Entonces
seleccione los elementos y muévalos a una nueva ubicación. Anim8or agregará Cuadros Clave (key
frames) para la ubicación de sus elementos de estos dos cuadros y llenará suavemente los cuadros
entre estas claves. Cuando presiona el botón reproducir (play)    su elemento ahora se moverá!.

usted también sabe que un camino spline (spline path) puede agregarse a la escena. Este es el
camino del elemento a través del espacio. Puede agregar más puntos a diferentes cuadros para
hacer movimientos complejos. Puede también editar la forma de las splines cliqueando en el botón 

 en la barra de herramientas.

La edición de la posición de objetos de describe con más detalle en el capítulo de Animación. Pero
aquí hay algunas pocas cosas que tener en cuenta:

Cuando el botón de animación está apagado   cualquier cambio que haga se
aplicará a la escena completa. Si mueve la cámara, por ejemplo, esta se moverá

igual en cada cuadro. Cuando el botón de animación está encendido   cambia
para que usted sólo pueda agregar o cambiar claves para el cuadro actual.

●   

Cuando usted mueve o rota un elemento que es hijo de otro elemento, entonces
el cambio será relativo a su padre. Lo mismo vale cuando usted rota un
elemento que está siguiendo su camino (path) de movimiento, el cambio es
relativo.

●   

Puede editar valores de claves individuales haciendo doble clic en la clave en la pista de tiempo. Vea
el próximo capítulo de animación para más detalles.

 

Animando Figuras con Secuencias
Puede también animar una figura agregando una secuencia entera de posiciones clave de una
secuencia. Si hace una secuencia que es un ciclo al caminar puede agregarla a la escena varias
veces en sucesión para hacer una larga caminata. Las secuencias que aparecen se muestran en la
pista mediante <---->. En la pista de abajo hay una secuencia de 12 cuadros que muestran tres
articulaciones.
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La secuencia en una escena está vinculada al editor de secuencias. Cualquier cambio que haga a la
secuencia inmediatamente aparecerá en sus escenas. Por esta razón usted no puede modificar
claves que son parte de una secuencia en el editor de escenas. Si trata de hacerlo, Anim8or le
preguntará si quiere convertir esta referencia particular de una secuencia en claves individuales y
continuar. Convertir una secuencia no alterará la sucesión original, pero los vínculos entre las
secuencias y la escena se perderán para que más allá de la edición de secuencia, no cambien las
claves en su escena.

 

Renderzando una Película .AVI
Para renderizar una película .avi, muestre la vista de cámara en la pantalla con View->Camera, y
entonces seleccione Render->RenderToFile. Seleccione AVI y cualquier otro parámetro que
prefiera, y Anim8or renderizará su película.
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8. Animación
Usted anima los elementos de su escena fijando su ubicación, color y tamaño, etc. de unos pocos
cuadrosclave (keyframes). La computadora provee los valores restante entre estas claves. Usted
tendrá más control sobre cómo animar las cosas agregando más claves. Además de su valor inicial
algunas claves tienen propiedades adicionales que puede editar para un mejor control.

Un segmento (segment) es el valor entre dos claves sucesivas en un rango de cuadros.  Puede
cambiar cuán rápido de mueven las cosas entre dos valores clave mediante la edición de las
propiedades de los segmentos.

 

Controladores
Los Controladores (Controllers) manejan los valores de las claves para la animación en el editor de
escenas. Cuando mueve, rota, o anima cualquier aspecto de un objeto que use clave, se crea un
controlador que sostiene la clave. Cada uno maneja sólo un aspecto de la escena. Por ejemplo uno
puede controlar la ubicación de un objeto, y otro el color de una luz. Ellos contienen todas las claves
respetando su valor y cualquier otro dato relacionado.

Si un aspecto de un objeto es constante para la escena y no es animado, no tiene controlador. La
única excepción es para los huesos. Ellos siempre tienen un controlador para cada eje en cada
articulación que se puede doblar. Esto hace que fácilmente pueda encontrar cuáles huesos pueden
moverse cuando está posicionando la figura.

 

Clases de Controladores
Hay varias clases de controladores. Cada uno usa una clase diferente de datos, o calcula entre
valores de diferente manera, dependiendo de las necesidades de la propiedad que se está
animando.

float Es un número como 10.5 o -150.  Como la mayoría de los controladores, los valores
intermedios se interpretan fácilmente.

point3 Point3s devuelve 3 números por cuadro. Cada valor se interpreta fácilmente sin
respetar los otros. Usa estos para posiciones y colores RGB.

orientation Un controlador de orientación devuelve una rotación por cuadro. Ellos pueden fijar la
orientación de un objeto o pueden ser usados para dirección de rotación. Cuando edita
estos valores en un diálogo, usted ve el PYR (pitch, yaw, roll) equivalente a la
orientación.

La Orientación es más complejo de lo que parece. Los ángulos interpretados
suavemente, no resultarán en un movimiento suave de rotación de sus modelos. Es
también importante también el orden en que se aplica la rotación sobre los ejes pitch
(eje x), yaw (eje Y) y roll (eje Z).  Anim8or usa PYR porque aplicando roll al final puede
fijarlo en 0 y sus elementos quedarán "derechos".

Es a menudo más fácil para usted ignorar los valores numéricos para orientación.
Simplemente oriente las cosas en la pantalla y deje el resto a la computadora.
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Boolean Los controladores Booleanos devuelven "si" o "no" como valor. Podría usarlo para la
visibilidad de los objetos si buscara desaparecerlos de repente. No hay ningún valor
"quizá" para un Booleano.

   

Editando Claves
Puede editar una clave mediante doble clic en su indicador de clave   en la pista, o o cliqueando en

el botón   para su controlados en el diálogo de propiedades del elemento.

Puede editar la el valor de la ubicación de las
claves x, y y z en el diálogo de ubicación de
claves, y agregar o borrar claves. Entrando el
número de cuadro le permite moverse a
cualquier cuadro en la escena, y cliqueando en
los botones + y - moverse al cuadro próximo y
previo. Usted puede ver, pero no cambiar los
valores de cuadro clave. Ellos son
proporcionados por la computadora.

EL botón Edit Seg le permite editar el segmento
al lado del cuadro actual.

   

Editando Segmentos
Oops! La propiedad de los segmentos no se encuentra en la versión 0.7. Esos valores no
significarán nada para usted ... por ahora. Si puedo hacerlos trabajar pronto se encontrarán
en la versión 0.71, pero debe ser paciente.  Lo Lamento!

Por defecto los valores varían en una proporción consistente entre claves. Pero no es lo que usted
siempre busca. Cuán rápidamente un personaje alcanza su plena velocidad cuando se empieza una
película, o cuánto tarda en detenerse cuando se se para la película, son elementos importantes en la
animación. Nosotros pensamos normalmente en objetos pequeños, livianos, que aceleran
rápidamente a máxima velocidad, pero los extensos o pesados toman más tiempo. En términos de
animación algo es llamado  ease out y ease in si es lento para empezar y detenerse.
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Editando las propiedades del segmento puede
cambiar la velocidad, el valor cambia de varias
maneras. Puede determinar el número de
cuadros que tomará un objeto para cambiar su
velocidad, tamaño, color, etc. al empezar o al
terminar un segmento con la determinación del
ease in y ease out.  Puede también elegir lo
opuesto: hard out y hard in donde puede hacer
que un objeto acelere al final, justo antes de
estrellarse en una pared para incrementar su
efecto visual.
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9. Buscador (Browser)
Vendrá pronto!  

This page was last updated on October 22, 2000. Copyright 2000 R. Steven Glanville
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10. Materiales
Cada superficie visible tiene un material. Cambiando sus varias propiedades, puede fijar la
apariencia de figuras y objetos. Los Materiales proveen riqueza y detalle que agrega un considerable
realismo a la escena. Puede hacerlos brillantes, mate, transparentes, y opacos. Puede texturar una
superficie con una imagen usada como un color de material, aclarar u oscurecer su color
base. Puede también usar una textura para controlar la transparencia.

Editor de Materiales
Usted usa el editor de materiales básico cada vez que necesita diseñar un color, textura,
transparencia, y otras propiedades visuales de la apariencia de un objeto. Usted abre el editor de
materiales haciendo doble clic en un material de la barra de herramienta de materiales, o desde el
diálogo de edición del objeto. Se muestra un ejemplo más abajo:

Muchas de las entradas serán obvias para varios de ustedes,  pero un par puede necesitar
probablemente una pequeña explicación, así que vamos a hacer una corta descripción en la
siguiente tabla:
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Material El nombre del material. El campo puede salir como material por defecto
"material00", pero es una buena idea dar a cada material un nombre
adecuado.

Ambiente
(Ambient)

Valor del componente ambiente. EL rango de los valores de ambiente,
difuso, y especular va de 0.0 a 1.0. Si se dejan en blanco, sus valores
se toman de los valores globales por defecto de los materiales.

Difuso (Diffuse) El valor del componente difuso.
Especular
(Specular) El valor del componente especular.

Transparencia*

(Trans)

La transparencia del material. Realmente, es la opacidad del material. 
1.0 es totalmente visible, mientras que 0.0 es completamente
transparente.

Brillo* (Brill) El factor de "brillosidad". Este valor cambia la apariencia del
componente difuso. Los objetos normales tienen un valor de 1.0. Si lo
incrementa en pequeños pasos hasta 1.5 o 2.0, el material toma un
brillo metálico, o para colores brillantes, una profunda y rica apariencia.

Rugosidad
(Rough)

La aspereza o rugosidad del material. Un alto valor hace que la
superficie luzca lustrosa. Está atemperado por el valor del componente
Especular. El rango de valores va de 1.0 (no muy lustroso) a 100.

Textura (Texture) Es el nombre de la textura actual que se usa con este material. as
texturas cambian sólo su color difuso.
Presione este botón para cargar y ver mapas de textura con el diálogo
propiedades de textura.

* Modo mezcla de texturas. Este botón hará aparecer un cuadro de
diálogo que le permitirá controlar la forma en que la textura interactúa
con el color del material base. Este no se habilita hasta que el material
tenga un mapa de textura.

Dos Caras

(Two Sided)

Puede seleccionar este ítem, para darle al objeto un material diferente
en el frente y la parte de atrás de las caraos. Los botones de frente
(front) y atrás (back) le mostrará cuál es la propiedad actual de la cara.

Borrar (Delete) Este botón borra un material. Se informará si está actualmente en
habilitado y se le brinda la posibilidad de cancelar el borrado.

*Nota: estas variables pueden afectar sólo imágenes renderizadas. Este efecto final puede mostrarse
solamente en forma parcial en sesiones interactivas. Algunas placas gráficas pueden mostrar
algunas otras, dependiendo de las características que ellas soporten.

Aquí se muestran imágenes de materiales simples y sus parámetros:

Cobre - Especular = 0.6, Rugosidad = 6, Brillosidad = 1.8, R=228, G=123, B=87

Goma - Difuso = 0.7, Especular = 0.0, R=3, G=139, B=251

Bronce - Especular = 0.7, Rugosidad = 8, Brillosidad = 2, R=228, G=187, B=24
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Vidrio - Especular = 0.7, Rugosidad = 32, Transparencia = 0.2, R=199, G=227, B=208

Plástico - Especular = 0.9, Rugosidad = 32, R=0, G=19, B=252

Perla - Ambiente=1.5, Difuso=-0.5, Especular = 2.0, Rugosidad = 99, R=255, G=138, B=138

No tenga temor a experimentar. Note que los valores para Perla están fuera del rango normal de
valores. El valor de ambiente es mayor que 1, el valor difuso es negativo (Lo que significa que la luz
actual oscurece la superficie), y el valor especular es mayor que 1.

Editor de Textura
El editor de textura le permite a usted cargar, ver, y manejar texturas para usar en sus

animaciones. Puede abrir este diálogo de adentro del editor de materiales con el botón  .  Se
muestra un ejemplo más abajo:

Puede cambiar el nombre de la textura en el campo Nombre (Name) del Mapa de Texturas y ver el
tamaño de la imagen que Anim8or usa para guardarla.
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El área Archivo Imagen (File Image) le brinda información sobre el archivo contenido la textura. El
camop Tipo (Type) puede estar en RGB para imágenes normales, o RGBA para archivos .gif con
color transparente. Si su textura es tipo RGBA entonces puede tener más flexibilidad en lo que
puede hacer con ella.

 

Modo Textura
Puede mezclar texturas con el color base y el material por varios caminos. Las Texturas con el canal
Alfa son mucho más versátiles. Usted fija la manera en que las texturas se comportan en el diálogo

de modo textura que se alcanza con el botón    del editor de materiales.

Puede usar el modo mezcla (blend mode) para controlar cómo el color de textura cambia el color del
material base. Calcomanía (Decal) simplemente reemplaza el color con la textura. Oscurecido
(Darken) multiplica el valor de cada componente del color que tiende a oscurecer la
imagen. Iluminado (Lighten) agrega los dos valores que sólo pueden hacer brillar a la imagen.

Si la textura tiene un canal alfa (como tiene el .gif transparente) puede usarla de tres formas
diferentes mediante la configuración del modo alfa (alpha mode). No (None) simplemente ignora el
alfa.  Capa (Layer) usa el canal alfa para mezclar entre colores de textura y colores de material. Final
(Final) usa el canal alfa como un valor final de transparencia del material.

Este es un ejemplo de qué puede hacer con una textura y un color de superficie. El color cian (azul
claro) de la textura es el color transparente en un archivo .gif:
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Nota: estos tipos de materiales no siempre se verán así en sus ventanas interactivas.  Las tarjetas
graficas tienen distintas capacidades. Si quiere estar seguro de que su modelo lucirá como estos es
mejor hacer una vista previa de la imagen ocasionalmente.
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